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Introduction 
 
Welcome to Ignite, the first music recording software entirely based on the creative 
workflow of musicians. Ignite lets you capture your ideas with unprecedented speed and 
combine individual ideas together to create a song. 

You won't have to worry about complicated setup, tracks, assignment of MIDI channels, 
or signal flow routing; thanks to its musician-centric approach, Ignite takes care of the 
necessary connections and lets you quickly start with what you really want: capturing your 
musical ideas! 
 
Main Features: 

• Captures your ideas in clips of variable length 

• Edit audio and MIDI clips 

• Clips can be arranged in variable groups as individual, Multi, and Song clips 

• Individual and grouped clip playback 

• Connected Akai Professional, Alesis, or M-Audio keyboard controllers are 
automatically set up and mapped to available controls 

• Smart MIDI players support you in developing your initial ideas 

• Over 275 instrument sounds included 

• Quick and easy sound selection by instrument family, category, and patch 

• Intuitive instrument sound editing on-screen or from your connected Akai 
Professional, Alesis, or M-Audio keyboard controller 

• Volume, pan, mute, and solo control over instruments 

• Five included effects: Equalizer, Compressor, Delay, Distortion, and Reverb 

• Share your ideas on social network platforms via SoundCloud, directly from within 
Ignite 

• Export WAV and MIDI files, which can be imported into most major DAW programs 
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Support and Feedback 
 
For complete system requirements, compatibility information, and product registration, 
visit the AIR website: airmusictech.com. 
 
For technical support, please contact us through the Support page of our website: 
airmusictech.com/support. 
 

Conventions 
 
Text 
 
The examples below explain when certain text styles are used: 
 
This style is used for important information, tips, or other helpful notes. 
 
This style is used for showing how to control Ignite using a supported Akai Professional, 
Alesis, or M-Audio keyboard controller. 
 
Key Commands 
 
You can use keyboard commands and combinations as shortcuts for many functions in 
Ignite. In this manual, keyboard shortcuts are indicated with brackets. For example, when 
you are asked to press [Ctrl]-[Z], this means that you should hold down the "Ctrl" key and 
press "Z" on your keyboard.  
 
Some modifier keys differ between Windows and Mac OS X systems. A keyboard shortcut 
that involves these may therefore read like this: 
 

Press [Ctrl]+[Z] (Windows) or [Command]+[Z] (Mac OS X) 
 
Please find a list of all available keyboard shortcuts in Keyboard Shortcuts. 

www.airmusictech.com
www.airmusictech.com/support
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Quick Tour 
 
When you start Ignite, you will see the Home screen in front and the main Ignite window in 
the background with the Sound Editor Tab selected. Using the Home screen options, you 
can watch tutorial videos, check and change your audio device settings, open a demo 
song and more (see Home). 
 
You can close the Home screen by clicking the Close button.  
 

 
Ignite Default View with New Session 



 

13 

 
From top to bottom, Ignite contains the following sections: 
 

Menu Bar 
 
The following menus are available on the menu bar: File, Edit, View, and Help. 
 
• The File menu contains functions that let you open and save Sessions, create a new 

Session and you can quit the program from here. 

• The Edit menu contains the undo/redo functions (see Undo and Redo), standard 
commands such as cut, copy, paste, and delete, and you can open the Home screen 
(see Home). 

• The Piano Roll sub-menu contains functions for the Piano Roll editor including note, 
grid, and tool selection (see Piano Roll Sub-Menu).  

• The View menu lets you switch between the tab views available in the upper half of 
the Ignite window.  

• The Help menu (see Help Menu) gives you access to the available program 
documentation. It also offers links to the online support and lets you check for 
program updates. 

 

Tab Bar 
 

 
 

Tab Bar 
 
In the upper half of the Ignite window, you will find the Tab Bar and the different tab views.  
 
To view a tab, simply click on the icon for the Tab you want to view. 
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Home 
 

 
 

Home 
 
The Home screen contains the following: 

• Video Tutorials: Ignite includes a series of online video tutorials that will help you 
learn how to use the application. Simply click on the video you want to view, and it 
will appear in a new window. 

• Demo Sessions: Ignite includes a series of Demo Sessions. To open a Demo 
Session, click the icon for the desired Session. 

• Audio Setup: This section will display all of the available, connected audio devices to 
your computer and allows you to select which audio device you want to use for 
playback and/or recording. For additional information on Audio Setup, see Audio 
Setup. 

• Auto-Update: Ignite can automatically check for updates. For more information see 
Auto-Update. 
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Choose 
 

 
 

Choose Tab 
 

Clicking on this tab opens the Choose Tab. This is the area where you can 
browse and select instruments to use in your session. For more information on 

browsing and selecting instruments, see Selecting an Instrument Sound. 
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Shape 
 

 
 

Shape Tab 
 

Clicking this tab opens the Shape Tab. This is the area where you can adjust the 
sound of the instrument you are using and also add one of the five included 

effects. There are two sections in the Shape Tab (see Shape Tab): Shape Instrument 
Sound (see Editing Instrument Sounds) and Effects (see Working With Effects). 
 
If you have connected your Akai Professional, Alesis, or M-Audio keyboard controller, the 
Shape Tab will show a corresponding graphic of your connected keyboard and controls 
(e.g., knobs, soft faders, pads, etc.).  

Hardware controls from your connected Akai Professional, Alesis, or M-Audio keyboard 
controller are automatically assigned to various functions depending on which Ignite 
instrument you are using. 

If multiple Akai Professional, Alesis, or M-Audio keyboard 
controllers are connected, a selection box with an alphabetical list 
of the connected keyboards will be shown. Click on the keyboard 
that you want to control Ignite with. 
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Play 
 

 
 

Play Tab showing Players On 
 

Clicking this tab opens the Play Tab. There are three Smart MIDI Players included 
with Ignite: Chord Player (see Chord Player), Phrase Player (see Phrase Player), 

Arpeggiator (see Arpeggiator). 
 
For more information on the Play Tab, see Play Tab. 
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Edit 
 

 
 

Edit Tab displaying a MIDI clip 
 
Clicking this tab opens the Edit Tab, where you can edit recorded audio (see Editing 
Audio) and MIDI data (see Piano Roll Editor). 
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Share 
 

 
 

Share Tab 
 
Clicking this tab opens the Share Tab where you can export your music in a variety of 
ways. See Exporting and Sharing Your Music. 
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Control Bar 
 

 
 
The Control Bar is in the center of the Ignite window. From here, you can: turn the 
metronome on/off; define the tempo; set the swing value, time signature, and key 
signature; turn auto-align notes on/off; control playback and recording; set the master 
output volume. 
 

Instrument Bar 
 

 
 
The area just below the Control Bar is the Instrument Bar. This displays all of the 
instruments you are using in the current Session. You can also add new instruments, 
reorder instruments, and access mixing controls from here. See Instrument Bar for 
details. 
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Arranger 
 

 
 

The Arranger, with clips 
 
Below the Instrument Bar is the Arranger. This is where your recorded audio and MIDI 
clips are displayed and where you can group, duplicate, and arrange your individual 
musical ideas into a larger composition. See Working with Clips and the Arranger for 
details. 



 

22 

 

Changing the Viewable Area of Tabs and Arranger 
 
Ignite uses one main window with a variety of tab Views. The Edit Tab and Arranger can 
be vertically resized to use more of the available window space.  

To resize either the Edit Tab or Arranger, simply drag the handles of the Control Bar 
(located to the left or right of the transport control) upwards or downwards. 
 

 
 

Resizing window controls 
 
Resizing will behave slightly differently, depending on which tab is currently displayed: 

• With the Choose, Shape, Play or Share Tab shown, you can only drag upwards to 
increase the viewable area of the Arranger. 

• With the Edit Tab shown, you can drag either upwards or downwards to customize 
the size of the Edit Tab and/or the Arranger. 

o Holding down [Ctrl] (Windows) or [Command] (Mac OS X) and double-clicking 
the Control Bar will maximize the Edit Tab.  

o When you switch to any other tab from the Edit Tab, the Ignite window will 
return to its default position.  

o When you switch back to the Edit Tab, the main window sections assume their 
last set size. 

 
You can double-click on the handles of the Control Bar to quickly maximize the Arranger 
or to return the Arranger to its default size. 

By either (A) pressing [Ctrl]+[F] (Windows) or [Command]+[F] (Mac OS X) on your 
computer keyboard or (B) selecting Switch View Modes on the View menu, you can 
toggle between different basic screen settings.  
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Focus 
 
"Focus" is a term used to describe an area of Ignite that can be controlled using the 
computer keyboard or connected keyboard controller. You will see a thin, white box 
surrounding the area of Ignite that currently has "focus." 
 
Ignite has three main focus areas: 

1. Tab Bar. 

2. Top Panel (Choose Tab, Shape Tab, Play Tab, Edit Tab, and Share Tab). 

3. Instrument Bar. 
 
To switch the focus: 

• Press the [Tab] key on your computer keyboard. 

• Click on an area you want to have Focus, such as the Tab Bar, Control Bar, or 
Arranger. 

 
The focus can also be changed using the following Akai Professional and M-Audio 
keyboards. 

• Akai Professional MAX49: Drum Pad Bank D Pads [1/3], [9/11]. 

• Akai Professional MAX25: Drum Pad Bank D Pads [7/8]. 

• Akai Professional MPK61 or MPK88: Drum Pad Bank D Pads [1/3], [9/11]. 

• Akai Professional MPK25 or MPK49: Drum Pad Bank D Pads [1/3], [7/9]. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: [Enter]+[Up] / 
[Enter]+[Down]. 

• M-Audio Axiom AIR Mini 32: [Enter]+[Up] / [Enter]+[Down]. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric Keypad +/-]. 

• M-Audio Axiom Pro 25: [F2/F3] with the [F1-4] button lit. 
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Navigation 
 
Ignite's Home screen, Tab Bar, Choose Tab, Effects Tab, and Share Tab can be navigated 
using the [Up], [Down], [Left], [Right], and [Enter] keys on your computer keyboard. 
 
It is also possible to navigate Ignite using the following keyboards. 

• Akai Professional MAX49: Drum Pad Bank D Pads [10/2/5/7]-Up/Down/Left/Right, 
[6]-Enter. 

• Akai Professional MAX25: Drum Pad Bank D Pads [1/2/3/4]-Up/Down/Left/Right, 
[5]-Enter. 

• Akai Professional MPK61 or MPK88: Drum Pad Bank D Pads [10/2/5/7]-
Up/Down/Left/Right, [6]-Enter. 

• Akai Professional MPK25 or MPK49: Drum Pad Bank D Pads [8/2/4/6]-
Up/Down/Left/Right, [5]-Enter. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: [Up], [Down], [Left], 
[Right], [Enter]. 

• M-Audio Axiom AIR Mini 32: [Up], [Down], [Left], [Right], [Enter]. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric Keypad 2/8/4/6]-
Up/Down/Left/Right, [Numeric Keypad 5]-Enter. 
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Using the Controls 
 
Knobs, volume sliders, and switches in Ignite look much like their real-world counterparts.  
 
Knobs 
 
Instead of "turning" a knob with your mouse, drag up or down to change the 
setting. 
 
 
 
 
 
 
Sliders 
 
To changes the value of a slider, drag the handle into the 
desired direction. 
 
 
 
Switches and Buttons 
 
Selector switches are used to select one of two 
or more possible settings. Click or drag the 
switch handle to the desired position with your 
mouse. 
 
Buttons trigger an action or set a feature to on or off. Simply click the respective button 
once to turn on and again to turn off. 
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Local Menus 
 
Local menus can be identified by a small 
downward pointing arrow either to the 
right or just below the button. To open a 
local menu, move the mouse pointer over 
the arrow symbol and hold down the 
mouse button until the menu opens. 
 
If you use a two-button mouse, you can 
also open the local menu by right-clicking 
on the arrow symbol. 
 
To select an option on a local menu, move the mouse pointer over the desired entry and 
click to select it. 
 
Input Fields 
 
Examples of input fields are tempo and swing on the Control Bar. To enter 
or change a value, first double-click on the value you want to change to 
select it, and then type in the desired value from your computer keyboard 
and press [Return]. 
 
You can also change the value by clicking on it and dragging upwards or downwards with 
your mouse. 



 

27 

 
Using a Mouse with a Scroll Wheel 
 
If you use a mouse with a scroll wheel, you can use it as follows: 
 
• To change the value of a setting, such as Swing, Tempo or Volume: Position your 

mouse over the desired control and use the Scroll Wheel to change the value of the 
control. 

• To navigate a view, such as the Edit Tab or Arranger: Position your mouse over the 
area you want to navigate and use the scroll wheel to shift the view up or down. 

• To zoom in/out of the Arranger or Edit Tab: Hold [Alt] on your computer keyboard 
while using the scroll wheel to zoom in or out. 
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Menu Bar 
 

File Menu 
 
New… 
 
Select this function to create a new Session. If another Session was already open when 
you created a new Session, you will be prompted to save the currently open before the 
new Session is created. 
 
Open... 
 
Select this function to open a previously saved Session. A standard file-handling dialog 
box appears where you can select a previously saved Session file. 
 
Open Recent 
 
Using this function, you can open a Session from a list of previously saved Sessions. Only 
recently opened Sessions will be displayed in the list. If you have not opened any Sessions 
recently, this list will be blank. 
 
Save 
 
Select this function to save a Session. A standard file-handling dialog box appears where 
you can name your Session and store it. Saving a Session will automatically create a 
separate folder for each Session. 
 
By default, Ignite saves and opens all user created files under the following path:  

• Windows: C:\users\username\MyMusic\Ignite 

• Mac OS X: /Music/Ignite 
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Save As… 
 
Select this function to save a Session under a new name. 
 
Import Audio… 
 
Using this function, you can add WAV files that are already on your computer to your 
Session. The imported files will be added to the Arranger. There is no limit to the number 
of files that can be imported at once. 
 
Each imported file will create a new Audio Instrument in the Instruments Bar. For 
instructions on how to assign imported audio clips to a single Audio Instrument in the 
Instrument Bar, see Assigning Clips to Different Instruments. 
 
For instructions on locking imported audio files to the Session tempo, see 
Locking/Unlocking Audio Clips to the Session Tempo. 
 
Important: Ignite only supports importing of WAV files. Other file formats are not 
supported. 

Tip: You can also add WAV files to your Session by dragging them from the Desktop into 
the Arranger. 
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Edit Menu 
 
Undo and Redo 
 
You can undo most actions in Ignite. This includes recording and editing, deletion or 
creation of notes and clips etc. Multiple levels of undo are available. This means you can 
go back and undo a series previous actions and commands.  

To undo the most recent action, select Undo on the Edit menu or press [Ctrl]+[Z] 
(Windows) or [Command]+[Z] (Mac OS X) on your computer keyboard. You can do this 
many times. 

Important: Undo will not work on changes or selections you make on main or local menus 
and on the controls in the Control Bar, including Tempo, Key Signature, Swing, 
Metronome On/Off settings and changes. 
 
You can also "undo the undo actions", called Redo. 

To redo the latest undo action, select Redo on the Edit menu or press [Ctrl]+[Y] 
(Windows) or [Command]+[Shift]+[Z] (Mac OS X) on your computer keyboard. 

You can do this many times to redo a series of actions. Actions can only be redone in the 
order in which they were undone originally. 
 
Automatic Drum Pad Mapping 
 
This entry is only available when a keyboard controller with drum pads is connected. 
 
If the entry is checked and a Drum Kit is selected, the keyboard's Drum Pads are mapped 
by Ignite instead of using MIDI mappings. Refer to your keyboard controller's 
documentation for details on how to manually assign drum pads to specific MIDI notes. 
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Duplicate Clip 
 
Selecting Duplicate Clip creates a copy of the clip or Multi clip that is currently selected in 
the Arranger. The duplicate will appear directly to the right of the selected Clip or Multi 
Clip. 
 
When a single clip is duplicated, a new Multi clip is created containing the original and 
duplicated clip. When a single Multi clip is duplicated, a new Song clip is created 
containing the original and duplicated Multi clip. 
 

Piano Roll Sub-Menu 
 
This sub-menu contains a number of functions that apply to the Piano Roll editor in the 
Edit Tab. 
 
• Select All: Use this function on the Edit menu to select all notes of the clip currently 

open in the Piano Roll editor. You can also press [Ctrl]+[A] (Windows) or 
[Command]+[A] (Mac OS X) on your computer keyboard for the same result. 

• Pointer, Pencil, and Velocity Tool: Select any of these three tools from the Edit 
menu to select the corresponding tool in the Piano Roll editor. You can also select 
the tools by pressing the [1], [2] or [3] keys on your computer keyboard. 

• Triplet Grid: Selecting this item toggles grid resolution in the Piano Roll editor 
between straight and triplet note values. To select the desired grid resolution type, 
select this function on the Edit menu or press [T] on your computer keyboard. 

• Align Selection to Grid: Using this function lets you automatically correct the 
positions of all notes that you have selected in the Piano Roll editor to the nearest 
grid position.  

• Align Note Lengths: This function lets you align the lengths of all selected notes in 
the Piano Roll editor to the nearest grid value.  

• Delete Controller Change Data: You can use this function to delete all recorded 
MIDI Controller Change (CC) data - such as Pitch Bend and Modulation - in the 
currently selected clip.  
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Arranger Gap Closing 
 
This function determines whether sections in Multi clips and Song clips that do not contain 
clips after an edit are automatically removed. 
 
Stop All Notes 
 
In rare occasions notes might hang and sound indefinitely. Then you can use this function 
to stop any "stuck" notes. To stop playback of hanging notes, select this function on the 
Edit menu. 
 
Preferences 
 
Windows users: Select this item to open the Home screen (see Home). 
 
Mac OS X users: Preferences is available in the Application Menu. 
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View Menu 
 
Home 
 
Select this item on the View menu or click the Home icon to open the Home screen. The 
Home screen functions are described in Home. 
 
Choose Tab 
 
This lets you open the Choose Tab, which is described in Choose Tab. 
 
Shape Tab 
 
Select this item on the View menu or press [2] on your computer keyboard to open the 
Shape Tab, where you can control the Arpeggiator as well as the Chord and Phrase 
Players. The Shape Tab is described in Shape Tab. 
 
Edit Tab 
 
Select this item on the View menu or press [4] on your computer keyboard to open the 
Edit Tab, where you can edit MIDI or Audio clips. The Edit Tab is described in Edit Tab.  
 
Sharing Tab 
 
Select this item on the View menu or click the Share Tab icon to open the Share Tab (see 
Exporting and Sharing Your Music). 
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Switch View Modes 
 
In order to get more space when editing or arranging your music, you can increase the 
space available for the Edit Tab or the Arranger. This can either be done manually—by 
dragging the Control Bar upward or downward—or by selecting this function. 
 
To toggle between the current space settings, select Switch View Modes from the 
View menu or press [F] on your computer keyboard until the desired view is shown. 
 
If you have not changed the size of the Piano Roll editor or the Arranger, you will see the 
available default settings. If you have changed size manually, the custom sizes are 
remembered and are shown instead. 
 
Tooltips 
 
Tooltips are text that appears when your mouse hovers over a control or icon in Ignite. 
You can enable or disable this function. 
 
To enable or disable Tooltips, select the function on the View menu so that it is ticked 
(enabled) or not ticked (disabled). 
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Help Menu 
 

This menu lets you access various resources that help you in using Ignite. 
 

Ignite Basics & Ignite User Guide 
 

By selecting one of these two menu entries, you can access the Ignite User Guide, which 
provides you with detailed information about Ignite, or Ignite Basics, a short guide that assists 
you in taking your first steps with Ignite. Click on the desired menu entry to open the 
corresponding document in your PDF reader software. 
 

Online Support 
 

This link opens your web browser and connects you with Ignite Online support.  
Important: An active Internet connection is required for viewing online support. 
 

Register Online 
 

Clicking this link opens your web browser and opens the Online Registration web page where 
you can register your copy of Ignite. 
 

Check for Updates... 
 

Selecting this function lets you check whether updates are available. This function is also 
available on the Home screen, described in Home. 
Important: An active Internet connection is required to check for updates. 
 

Reset Ignored Updates 
 

If you have ignored available Ignite updates using Skip this update on the Home screen, you 
can reset this, so that Ignite will again remind you that an update is available. 
 

About 
 

Selecting this opens the Ignite About screen that informs you of which version you are using. 
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Home 
 

 
 
The Home screen contains a variety of functions, which include audio device or sound 
card settings, software auto-update, video tutorials, and Demo Sessions.  
 
You can open the Home screen by doing any of the following: 

• Clicking the Home screen icon in the top left corner of the Ignite window 

• Selecting Preferences in the Edit menu (Windows) or from the Application 
Menu (Mac OS X) 

• Pressing [Ctrl]+ (Windows) or [Command]+ (Mac OS X) on your computer 
keyboard 

• Selecting Home in the View menu 
 
The Home screen is organized into two levels: 

• The first level shows the main categories. 

• The second level holds the individual options available for a main category. 
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The following function areas are available and can be accessed by clicking the 
corresponding icon: 
 

Icon Opens What you can do here 

 

Tutorial Videos Watch online tutorial videos to learn more about 
Ignite. 

 

Demo Sessions Open demo Sessions. 

 

Audio Setup 
Select available audio inputs and outputs, change 
sample rate and buffer size. 

 

Auto-Update Get the latest version of Ignite. 

 
To get back to the main categories, click the upward pointing arrow in 
the top left corner. 
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Video Tutorials 
 
Ignite includes a series of online video tutorials that will help you learn the different 
workflows and features included. Simply click on the video you want to view and it will 
appear in a new window. 
 
Important: You will need to be connected to the Internet and have Adobe Flash installed 
in order to view these videos. 
 

Demo Sessions 
 
Ignite includes a collection of Demo Sessions to demonstrate different features and 
musical styles. Click on the Demo Session you want to load and it will appear in a new 
Session 
 
If a previous Session is open, a dialog box will appear where you can save it, before the 
Demo Session opens. 
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Audio Setup 
 

 
 
This function area displays all audio devices that are currently available on your computer. 
You can check and make changes to your audio device settings here. If you have several 
audio devices installed in or connected to your computer, Ignite will automatically check 
and select an audio output device upon start-up. 
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Audio Output 
 
To change the device that Ignite uses for playing back your Session: 
1. Select the desired audio output device by clicking on its icon. A white frame indicates 

the currently selected audio output device. 
2. If the output device offers more than two output channels, you can select an output 

channel pair by clicking on the value next to the word Output. A local menu appears 
where you can select the desired stereo output pair.  

 
Important: Ignite supports two audio outputs only. 
 

Audio Input 
 
Ignite supports ASIO (Windows), WASAPI (Windows), and Core Audio (Mac OS X) devices. 
If you are using a WASAPI or Core Audio device, the available devices that Ignite can use 
for recording audio are shown in the lower half of the screen. If you are using an ASIO 
device, you will see only one row of devices. 
 
To change the device that Ignite uses for recording audio into your Session: 
1. Select the desired audio input device by clicking on its icon. A white frame indicates 

the currently selected audio input device. 
2. If the input device offers more than one input channel, you can select an input 

channel by clicking on the value next to the word Input. A local menu appears where 
you can select the desired input. If the Mono / Stereo switch is set to stereo, the 
inputs will be shown in pairs. At this time, Ignite supports a single mono or stereo 
audio input only. 

3. You can confirm that audio input is working by checking if the Input Level meter is 
moving up and down when audio is being input into the selected device. 

 
Windows users: If you are using an ASIO device, you will experience better audio 
performance than with a WASAPI device.  

ASIO requires that the same device be used for playing back and recording audio so the 
Output and Input sections will be shown together in the top half of the screen. 
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Mono / Stereo Switch 
 
Click on this switch to toggle the audio input between mono and stereo. 
 
• If you are recording using a single microphone or a single Guitar input, set this switch 

to mono. 

• If you are recording using a stereo device, such as a synthesizer, set this switch to 
stereo. 

• If you are recording two different sources, such as vocals and guitar, at the same 
time, set this switch to Stereo 

 
Important: When recording stereo sources, Ignite will create only one clip, meaning the 
left and right inputs will be combined into one clip rather than two separate clips.  
 
Sample Rate 
 
The sample rate determines the resolution of the audio input and output. By default, new 
Sessions are set to 44100 (44.1 kHz). If you are happy with the sound you are getting, you 
do not need to change this setting. 
 
If you wish to change the sample rate, click on the currently set value. A local menu 
appears where you can select another sample rate, if necessary and available. 
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Buffer Size 
 
Ignite must convert the audio output from digital (in your computer) to analog (to your 
speakers or headphones). This process requires processing power and a little time, which 
may cause pops, clicks, and other audio artifacts. The buffer can be seen as a storage 
place on your audio card where chunks of digital audio are temporarily stored before they 
are converted into a regular audio signal. This is done to ensure a steady audio output 
flow without interruptions. If everything works fine, you do not need to make any changes 
here. 
 
If you wish to change the Buffer size, and your audio output device supports this, click on 
the current value and select one of the values that may be available in the local menu that 
appears. 
 

Auto-Update 
 
This function area lets you check whether updates are available and to download or skip 
updates. It also shows information about the currently installed version. Click on the 
desired function to start the respective action. 
 
Enabling and Disabling Auto-Update Notifications 
 
Ignite also includes an automatic update notification system. If you enable the 
Automatically Check for Updates option at the lower right corner of the window, you will 
be automatically notified when a new version of Ignite is available. 
 
Important: You must have an active Internet connection in order to check for updates. 
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Functions at the Bottom of the Home Screen 
 
The following functions are always visible, no matter which function icon you have 
currently selected. 
 
• New: Click this to create a new Session. If another Session was already open when 

you created a new Session, you will be prompted to save the currently open before 
the new Session is created. 

• Open: Click this to open a previously saved Session. A standard OS file-handling 
dialog appears where you can select a previously saved Session file. 

• Show on Startup: If you wish to see the Home screen each time you start the 
program, enable the "Show on startup" function.  

• Close: Click this button to close the Home screen. You can also close the Home 
screen by clicking anywhere outside of the Home screen. 

 



 

44 

 

Choose Tab 
 

 
 
The Sounds browser is located in the Choose Tab and is used for browsing and selecting 
instrument sounds. To show the Choose Tab, simply click on the Choose Tab icon.  
 

Selecting an Instrument Sound 
 
In the Sounds Browser, instruments are organized into three levels: 

• First Level: Instrument Family (e.g.: Guitars, Bass, Drums, Keyboards, Strings, 
etc.). 

• Second Level: Instrument Categories (e.g., in Guitars: Electric Guitars, Acoustic 
Guitars, etc.). 

• Third Level: Individual sound patches (e.g., in Guitars  Electric Guitars: Clean E 
Guitar, Rock Lead, Rock Crunch, etc.). 
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To add an instrument sound: 
 
1. Click the browse arrows located at the top of the Sounds browser, until the desired 

instrument family icon is found: 
 

 
 

2. Click the desired instrument family icon to select it: 
 

 
 

You can now browse the available instrument categories at the top of the Sounds 
Browser. The individual sounds patches available for the currently selected 
instrument category are shown. 

 
3. Use the browse arrows or drag with the mouse to select the desired instrument 

category. 
 
4. Click the icon to select the instrument category. The available 

sound patches are now visible. If more patches are available 
than fit in the browser section, use the scroll bar to the right to 
view. 
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5. Click the desired sound patch. Two icons will appear on the patch: Replace 

Instrument on the left and Create New Instrument on the right. 
 

6. To preview the patch, play a few notes or chords on your keyboard to 
hear the selected patch. While previewing, the Choose Tab icon will be 
blue. You can adjust the sound by using the controls in the Shape Tab. 
To learn more, see Editing Instrument Sounds. (You can exit this preview mode by 
pressing the [Esc] key on your computer's keyboard, choosing another instrument, or 
selecting a clip.) 

 

7. Click the Create New Instrument icon to create a new instrument. The patch loads 
and you can play it from your keyboard. (If you edited the instrument patch while 
previewing it, it will retain those edits.) The instrument icon is also added to the 
Instruments Bar.  

 

Here's an example: 

1. With the Sounds browser on the Choose Tab, navigate to the Guitars family and 
click the icon to select. The Electric Guitars sub-category will now be shown.  

2. Click the Pop Lead instrument sound patch. The Replace Instrument and Create 
New Instrument icons will now be shown on the Pop Lead instrument sound patch.  

3. Play a few notes or chords on your keyboard to test the sound. (You can exit this 
preview mode by pressing the [Esc] key on your computer's keyboard, choosing 
another instrument, or selecting a clip.) 

4. Click the Create New Instrument icon. The Pop Lead Guitar instrument sound—with 
any edits you made while previewing it—is now loaded and the instrument is added 
to the Instrument Bar. 

 

If necessary, repeat Steps 1 to 3 until you have found the desired sound. 
 

To go back to the Instrument Family level and select another 
family of instruments, click the Back button (upward pointing 
arrow) to the left of the instrument categories or press the [Esc] 
key on your computer's keyboard. 
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If You Have No Sound 
 
• Check whether the output meter in Ignite is lighting up when you play your keyboard. 

• Check the USB connection from your keyboard to your computer. 

• Check your speaker or headphone connections and volume. 

• Verify the audio output settings of your computer's operating system. 

• If you are using an external audio device or sound card please refer to the 
manufacturer's manual for instructions on verifying your sound options. 

 

Changing Instruments 
 
You can change instruments at any time. Changing the instrument sound for an individual 
clip will change the instrument sound for all clips using that instrument. 
 
1. Select the Instrument you want to change in the Instrument Bar by clicking on it. 

2. Navigate to the Sounds Browser and select the desired instrument patch by clicking 
on it. 

3. Click the Replace Instrument icon to replace the current instrument with the new 
instrument. 

 
Important: All of the clips that use the selected instrument will be changed to the new 
instrument. 
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Working with Audio Instrument Presets 
 
Ignite includes many audio instrument presets, which can be 
selected and added to your currently open session as described 
in Selecting an Instrument Sound.  

These audio instrument presets are different from the other 
instrument categories in that they are exclusively for recording 
audio sources. Another difference between audio instrument 
presets and the other instruments is that the audio instrument 
presets contain effects preset chains. 

Each sub-category of audio instrument presets also includes a No Effects preset, which 
do not include any effects. 

You can modify, edit, add or remove the effects included in these audio instrument 
presets (see Working with Effects). 
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Using Shortcuts in the Choose Tab 
 
Shortcuts provide a quick way to select sounds.  
 
An example of using keyboard shortcuts: 

1. Select an instrument family using [Left] / [Right]. Press [Return], [Enter] or [Down] to 
display the selected instrument family's category and sound page. 

2. Use [Left] / [Right] to select an instrument category.  

3. When the instrument category bar has focus, use [Up] or [Esc] to return to the 
instrument family browser. 

4. When the desired category is displayed, press [Return], [Enter] or [Down] to switch 
the focus to the sounds area. 

5. When a sound on the top row is selected, use [Up] or [Esc] to set the focus back to 
the instrument category bar. 

6. Use [Up] / [Down] / [Left] / [Right] to select a sound. 

7. Press [Return] or [Enter] to display the Create New Instrument and Replace 
Instrument buttons. Select the desired button using [Left] / [Right] and press [Return] 
/ [Enter] to confirm. 

 
For a complete list of keyboard shortcuts, please see Keyboard Shortcuts. 
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Shape Tab 
 
The Shape Tab includes two areas: 

• Edit Shape: This area allows you to edit the instrument sound of a selected 
instrument. 

• Effects: This area allows you to add and change effects for a selected instrument. 
 

Editing Instrument Sounds 
 

 
 

Shape Tab displaying the Edit Shape section 
   
Clicking the Edit Shape icon will bring up the Sound Editor for the selected instrument. 
This is where you can edit the sound of the currently selected instrument patch. Available 
parameters vary, depending on which instrument you are editing. 
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If you are using a supported Akai Professional, Alesis, or M-Audio keyboard controller and it is 
currently connected to your computer, you will see a graphical representation of your keyboard 
on the screen. 
When the Shape Tab is visible, Shape parameters and Drum Pads are automatically mapped to 
the knobs / ribbon faders or Drum Pads on your connected Akai Professional, Alesis, or M-Audio 
keyboard controller. See Automatic Drum Pad Mapping for information on how to enable / 
disable automatic mapping: 

• Akai Professional MAX25 or MAX49: Faders [1-6]. 

• Akai Professional MPK25, MPK49, MPK61, or MPK88: Knobs Bank A [K1-K6]. 

• Akai Professional MPK mini or LPD8: Knobs [1-6]. 

• Alesis QX25, QX49, or QX61: Knobs [K1-K6]. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: Knobs [1-6] with the INST./FX 
button next to the knobs lit. 

• M-Audio Axiom AIR Mini 32: Knobs [1-6] in INST./FX mode. To set the mode to INST./FX, 
press the HyperControl button until the LED next to "Inst/FX" is lit. 

• M-Audio Axiom Pro 25, Axiom Pro 49, or Axiom Pro 61: Knobs [E1-E6]. 

• M-Audio Axiom 25, Axiom 49, or Axiom 61: Knobs [E1-E6]. 

• M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or Oxygen 88: Knobs [C1-C6]. 

• M-Audio Venom: Knobs Bank C [1-4] and Bank D [1-2]. 
 
If your Akai Professional, Alesis, or M-Audio keyboard controller does not have knobs or pads or 
is not connected, you can adjust the instrument settings on screen using the computer mouse. 
Mouse techniques are described in Using the Controls.  
 
To edit an instrument, select it in the Instruments Bar, located at the top of the Arranger. The 
current instrument settings are now shown in the Sound editor. 

Important: 
• Changes to instrument settings are saved in your Session. 

• If you edit the instrument patch while previewing it, it will retain those edits if/when you 
load it. 

• Audio Instrument Presets do not have any editable controls in the Edit Shape section. 
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Working with Effects 
 

 
 
Clicking the FX icon will bring up the Effects area for the selected instrument. This is 
where you can add Effects to make further changes to the way an instrument sounds. Up 
to six Effects can be added for each instrument, each of which has four parameters that 
can be adjusted. 
 

Using Shortcuts in the Effects Tab 
 
Shortcuts provide a quick way to select effects: 
1. Select an effect slot using [Left] / [Right]. Press [Return] or [Enter] to display the 

Effects browser. 
2. Use [Left], [Right], [Up], [Down] to select an effect or [Esc] to exit. 
3. When the desired effect is selected, press [Return] or [Enter] to select it, or [Esc] to 

exit. 
 
For a complete list of keyboard shortcuts, see Keyboard Shortcuts. 
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When the Effects Tab is visible, the parameters of the selected effect are automatically 
mapped to the knobs / ribbon faders on your connected Akai Professional, Alesis, or M-
Audio keyboard controller:

• Akai Professional MAX49: Drum Pad Bank D Pads [5/7]-Select Previous/Next Effect 

Slot, [10/2]-Effect On/Off, [6] – Add / Replace Effect, Faders [1-4]-Effect Parameters. 

• Akai Professional MAX25: Drum Pad Bank D Pads [3/4]-Select Previous/Next Effect 
Slot, [1/2]-Effect On/Off, [5]-Add/Replace Effect, Faders [1-4]-Effect Parameters. 

• Akai Professional MPK61 or MPK88: Drum Pad Bank D Pads [5/7]-Select 
Previous/Next Effect Slot, [5/2]-Effect On/Off, [6]-Add/Replace Effect, Knobs Bank A 
[K1-K4]-Effects Parameters. 

• Akai Professional MPK49: Drum Pad Bank D Pads [4/6]-Select Previous/Next Effect 
Slot, [8/2]-Effect On/Off, [5]-Add/Replace Effect, Knobs Bank A [K1-K4]-Effects 
Parameters. 

• Akai Professional MPK25: Drum Pad Bank D Pads [4/6]-Select Previous/Next Effect 
Slot, [8/2]-Effect On/Off, [5]-Add/Replace Effect, Knobs Bank A [K1], [K2], [K5], [K6]-
Effects Parameters. 

• Akai Professional MPK mini or LPD8: Knobs [1], [2], [5], [6]. 

• Alesis QX49 or QX61: Knobs [K1], [K2], [K5], [K6]. 

• Alesis QX25: Knobs [K1-K4]. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: [Left/Right]-Select 
Previous/Next Effect Slot, [Up/Down]-Effect On/Off, [6]-Add / Replace Effect, Knobs 
[1], [2], [5], [6] with the INST./FX button next to the knobs lit-Effects Parameters 

• M-Audio Axiom AIR Mini 32: [Left/Right]-Select Previous/Next Effect Slot, 
[Up/Down]-Effect On/Off, [6]-Add / Replace Effect, Knobs [1], [2], [5], [6] in INST./FX 
mode. To set the mode to INST./FX, press the HyperControl button until the LED next 
to "Inst/FX" is lit. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric Keypad 4/6]-Select 
Previous/Next Effect Slot, [Numeric Keypad 2/8]-Effect On/Off, [Numeric Keypad 5]-
Add / Replace Effect, Knobs [E1], [E2], [E5], [E6]. 
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• M-Audio Axiom Pro 25: Knobs [E1], [E2], [E5], [E6]. 

• M-Audio Axiom 25, Axiom 49, or Axiom 61: Knobs [E1], [E2], [E5], [E6]. 

• M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or Oxygen 88: Knobs [C1], [C2], [C5], 
[C6]. 

• M-Audio Venom: Knobs Bank C [1-4]. 
 
If your Akai Professional, Alesis, or M-Audio keyboard controller does not have knobs or is 
not connected, you can adjust the effect settings on screen using the computer mouse. 
Mouse techniques are described in Using the Controls. 
 
To add a new Effect or change an existing Effect:  

1. Click on the Add Effect or Replace Effect control. The available Effects are shown. 

2. Click on an Effect to add it. 
 
To compare instrument sounds without a specific Effect, click the On/Off switch with your 
mouse. Effects can also be removed completely by clicking on the Remove Effect button. 
 
Tip: You can reorder your effects by clicking and dragging effects to new locations in the 
effects chain. Reordering your effects will change the sound—you can hear the changes 
immediately. 
 
If you are not familiar with using Effects or want to find a starting point for adjustment, 
Ignite includes a number of Presets. Select a Preset from each Effects local menu. 
 
Important: Changes to Effects are saved in your Session. 
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Working with Reverb 
 

Ignite also includes two reverbs per instrument. Reverb can be used to "place" an 
instrument in a "space." 
 

When the Effects Tab is visible, Reverb is automatically mapped to the knobs / ribbon 
faders on your connected Akai Professional, Alesis, or M-Audio keyboard.

• Akai Professional MAX25 or MAX49: Faders [7], [8]. 

• Akai Professional MPK49, MPK61, or MPK88: Knobs Bank A [K7], [K8]. 

• Akai Professional MPK25: Knobs Bank A [K4], [K8]. 

• Akai Professional MPK mini or LPD8: Knobs [4], [8]. 

• Alesis QX49 or QX61: Knobs [K4], [K8]. 

• Alesis QX25: Knobs [K7], [K8]. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: Knobs [4], [8] with the 
INST./FX button next to the knobs lit. 

• M-Audio Axiom AIR Mini 32: Knobs [4], [8] in INST./FX mode. To set the mode to 
INST./FX, press the HyperControl button until the LED next to "Inst/FX" is lit. 

• M-Audio Axiom Pro 25, Axiom Pro 49, or Axiom Pro 61: Knobs [E4], [E8]. 

• M-Audio Axiom 25, Axiom 49 , or Axiom 61: Knobs [E4], [E8]. 

• M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or Oxygen 88: Knobs [C4], [C8]. 

• M-Audio Venom: Knobs Bank D [1], [2]. 
If your Akai Professional, Alesis, or M-Audio keyboard controller does not have knobs or is 
not connected, you can adjust the Reverb settings on screen using the computer mouse. 
Mouse techniques are described in Using the Controls.  
 

Select the type of reverb from the local menus. Turn the knob clockwise to increase the 
amount of reverb. 

The Reverbs do not have on/off controls. To "turn off" either or both reverbs, simply set 
the Amount to 0% (maximum left). 

Important: Changes to Reverb are saved in your Session. 
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Play Tab 
 

 
 
Clicking the Play Tab opens the Smart MIDI Players in the upper half of the Ignite window. 
Ignite includes three different Smart MIDI players: 
 
• Chord Player: This player offers a variety of methods to create chord 

accompaniment. You can press any key on your keyboard controller and the 
diatonically correct chord triad will play in the selected musical style. You can change 
variations and add chord extensions as well. This is a great way to take simple 
phrases and create sophisticated accompaniment parts. More information can be 
found in Chord Player. 

• Phrase Player: This Player creates melodic phrases or drum patterns in a variety of 
musical styles. Phrases are triggered with one finger and a variety of phrase patterns 
are available for each musical style. Notes within a phrase can be auto-corrected to 
match the scale of the selected key signature. More information is available in 
Phrase Player.  

• Arpeggiator: The Arpeggiator lets you create various arpeggio variants and 
rhythmically played chords. See Arpeggiator for more information. 

 
These creative players offer very useful functionality that you can use to quickly transform 
a simple musical idea into a more complex part. You can record parts using the Players.  
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Player Controls 
 
The controls described here are available for all Players. All other Player controls are 
described in the respective Player's description. 

The Play Tab is automatically set to a suitable default when a new instrument is previewed 
or created in the Choose Tab. When an instrument is replaced by another instrument from 
the same family and the Play Tab is on, the settings are retained. 
 
Important: If you edit the instrument patch while previewing it, it will retain those edits 
if/when you load it. 
 
Players On/Off Switch 
 
This switch is used to activate or deactivate the Players section. To activate 
or deactivate the Players, drag the switch handle to the On or Off position.  
 
The Play Tab graphic will light up in blue to remind you that the Players section is currently 
active. 
 
You can always use the keyboard, Pitch Bend, and Modulation wheel on your connected 
Akai Professional, Alesis, or M-Audio keyboard controller regardless of whether the 
Players are on or off. 
 
Mode Switch 
 
You can use this switch to select one of the three available Player 
modules. Drag the switch handle to the desired position to activate 
the respective Player. 
 
Note: For Drums and Percussion instruments, only the Phrase Player is available. The 
Chord and Arpeggiator Players are not available when working with Drums and/or 
Percussion instruments. 
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Pitch Bend Wheel (PB) 
 
The Pitch Bend wheel is a standard controller on MIDI keyboards. This on-
screen version is a virtual representation of the corresponding control on your 
controller keyboard. Both are used to create variable and continuous pitch 
changes ("portamento"), which are commonly used by instruments such as 
synthesizers, strings, brass, woodwinds, fretless bass, guitar, etc. 
 
Drag the wheel up or down to bend the pitch upwards or downwards. When 
you let go of the mouse button, the wheel will automatically return to its neutral 
center position. 
 
Modulation Wheel (Mod) 
 
A Modulation wheel is another standard control on MIDI keyboards. It is often 
used to control vibrato and can also be applied to control other parameters. 
  
The further up you drag the wheel, the more modulation is applied to the 
sound. When you let go of the mouse button, the wheel will retain its last 
setting. The wheel's neutral position (no modulation) is at the bottom. 
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On-Screen Keyboard Octave Buttons 
 
You can use these two buttons to shift the visible octave range of the 
on-screen keyboard up or down. The octave controls shown in the on-
screen keyboard only control the viewable area of the on-screen 
keyboard.  
 
Click the left Octave button to shift the visible octave range downwards and the right 
Octave button to shift the range upwards. 
 
To change the octave on your connected Akai Professional, Alesis, or M-Audio keyboard 
controller, use the Octave controls on the keyboard itself.
 
On-Screen Keyboard 
 

 
 
This velocity sensitive keyboard has a total range from C-2 to C8 and 61 visible keys. It is 
the stand-in for connected Controller Keyboard hardware and you can play it by clicking 
keys with the mouse. The higher up you click a key, the lower the velocity value applied to 
the resulting note and vice versa. You can find a short explanation of what velocity is in 
Editing Velocity. 
 
The visible key range of the on-screen keyboard can be shifted using the on-screen 
Keyboard Octave buttons as described above.  
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Using Shortcuts in the Play Tab 
 
For a full list of keyboard shortcuts in the Play Tab, see Keyboard Shortcuts. 
 
When the Play Tab is visible, Play Tab parameters are automatically mapped to the knobs or 
ribbon faders on your connected Akai Professional, Alesis, or M-Audio keyboard controller. 

• Akai Professional MAX49: Drum Pad Bank D Pads [6]-Players On/Off, [5/7]-Switch Mode, 
[10/2]-Move to Key Sig. On/Off, Faders [1-4]-Play Tab Parameters. 

• Akai Professional MAX25: Drum Pad Bank D Pads [5]-Players On/Off, [3/4]-Switch Mode, 
[1/2]-Move to Key Sig. On/Off, Faders [1-4]-Play Tab Parameters. 

• Akai Professional MPK61 or MPK88: Drum Pad Bank D [6]-Players On/Off, [5/7]-Switch 
Mode, [10/2]-Move to Key Sig. On/Off, Knobs Bank A [K1-K4]-Play Tab Parameters.

• Akai Professional MPK25 or MPK49: Drum Pad Bank D Pads [5]-Players On/Off, [4/6]-
Switch Mode, [8/2]-Move to Key Sig. On/Off, Knobs Bank A [K1-K4]-Play Tab Parameters. 

• Akai Professional MPK mini or LPD8: Knobs [1-4]-Play Tab Parameters. 

• Alesis QX25, QX49, or 61: Knobs [K1-K4]-Play Tab Parameters. 

• M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom AIR 61: [Enter]-Players On/Off, 
[Left/Right]-Switch Mode, [Up/Down]-Move to Key Sig. On/Off, Knobs [1-4] with the 
INST./FX button next to the knobs lit-Play Tab Parameters. 

• M-Audio Axiom AIR Mini 32: [Enter]-Players On/Off, [Left/Right]-Switch Mode, 
[Up/Down]-Move to Key Sig. On/Off, Knobs [1-4] in INST./FX mode-Play Tab Parameters. 
To set the mode to INST./FX, press the HyperControl button until the LED next to "Inst/FX" 
is lit. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric Keypad 5]-Players On/Off, [Numeric 
Keypad 4/6]-Switch Mode, [Numeric Keypad 2/8]-Move to Key Sig. On/Off, Knobs [E1-E4]-
Play Tab Parameters. 

• M-Audio Axiom Pro 25: Knobs [E1-E4]-Play Tab Parameters. 

• M-Audio Axiom 25, Axiom 49, or Axiom 61: Knobs [E1-E4]-Play Tab Parameters. 

• M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or Oxygen 88: Knobs [C1-C4]-Play Tab 
Parameters. 

• M-Audio Venom: Knobs Bank C [1-4]-Play Tab Parameters. 
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Chord Player 
 

 
 
The Chord Player lets you create chord accompaniment with smart and adjustable 
voicing. To activate the Chord Player: 

1. Make sure you have selected the desired instrument patch in the Instrument Bar. 

2. Set the Players switch to On. 

3. Drag the Mode switch handle to Chord. 
 
Important: Only melodic instruments can be used with the Chord Player, such as piano, 
guitar, etc. Drums cannot be used with the Chord Player. 
 
The Playing Style is automatically set to default to the instrument family of the selected 
instrument. A Musical Style is also set by default. You can change either of these two 
settings as described below. 
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Playing Style & Musical Style Menus 
 

 
 
The two style selections that you make here provide you with different rhythmic 
accompaniment patterns. Click the arrow symbol to open one of these menus. 

In the Playing Style menu, select an instrument from the list. The selection you make here 
has an impact on what's available on the Musical Style local menu.  

In the Musical Style menu, select the musical style the instrument should use. Now you 
can select one of the available chord phrases. This is done using the Phrase Keys. 
 
Phrase Keys 
 
With Chord mode active, twelve different chord 
phrases are available for each musical style. 
These can be selected using the keys in the C1 
octave of your controller keyboard or on the on-
screen keyboard. On the on-screen keyboard, 
the phrase keys are marked by a different color. 
You can audition the available phrases by 
individually pressing each key in the C1 octave. 

The chord phrase keys are used for selecting any of the available chord phrases. Available 
phrases are played based on the last note played. For example, if the last note played was 
C, all of the phrases would be based on C. 

To define an octave for the resulting accompaniment phrase, you can use the On-screen 
Keyboard Octave buttons, described in On-Screen Keyboard Octave Buttons. 
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Move to Key Signature (Move to Key Sig.) 
 
When you activate this function, notes and chords you play are automatically adjusted to 
the global key signature that you select in the Key Signature local menu on the Control 
Bar. 
 
When you create chords by pressing one key and Move To Key Sig. is On, the Chord 
Player will create diatonically correct major or minor chord triads according to the key 
signature selected in the key signature local menus on the Control Bar. 
 
For C major this would be: C major, Dsus4, D minor, Esus4, E minor, F major, Gsus4, G 
major, Asus4, A minor, B diminished. 
 
When Move To Key Sig. is On and you use a second finger to play a key to the left of the 
first, Chord Mode will deliver additional chords that fit in the scale, such as 6th, dim7 or 
sus4 chords. Move to Key Signature picks the closest fitting option. 
 
Chord Display 
 
This display shows the chord Ignite has interpreted, based on the note(s) 
you are playing. 
 
 
Feel Knob 
 
Using this rotary control, you can determine the degree to which the velocity 
values of individual keys within a chord are randomized to create a more 
natural, human playing style. 
 
Click the knob and drag upwards or downwards. 
 
The velocity difference within the phrase increases the more you turn this knob up. 
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Speed Knob 
 
The speed knob is used to determine the playback speed of the current chord 
accompaniment. Three speed settings are available: Normal, Half, and 
Double. 
 
To select a speed setting, click the knob and drag upward or downward. 
 
Spread Knob 
 
Use this control to change chord voicing and the manner in which it is spread 
across the keyboard. Eight settings are available: Octaves Only, 2-Note, 3-
Note, Very Narrow, Narrow, Medium, Wide, and Ultra Wide. 
 
Click the knob and drag upwards or downwards to select one of the eight 
available options. 
 
Octave Knob 
 
Use this rotary control to select the octave range for the chord phrase. Chord 
voicing may be spread across more than one octave, but all will be shifted 
accordingly.  
 
Click the knob and drag upward or downward to select an octave for the 
current chord phrase. 
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Using the Chord Player 
 
Press one or more keys relating to a chord in any inversion and in any octave and the 
Chord Player will play the selected rhythmical pattern using those notes that it recognizes 
as a chord.  

The Chord Player calculates this chord based on the keys that you press. If chord 
recognition detects more than one possible chord, it either creates a simpler chord version 
or uses the chord whose root key is the lowest held note.  

Here is a list of all chords the player can recognize (the list refers to the root key C): 
  

C Cmaj7♭5 C6/9 Cmin(maj7) Csus2 

C7 Cdim7 Cmaj9 Caug7 Cmin9 

C6 C7sus4 Cmin Cmin7♭5 Cmin9(add9) 

Cmaj7 C9 Cmin7 Cdim Cmin6/9 

Caug C(add9) Cmin6 Csus4 C7(♭9) 

C(♭5)     

 
You can also create four different chord types in the following ways: 

• Press one key only to create a major chord. 

• Press one key and the next white key to the left of it to create a major seventh (maj7) 
chord. 

• Press one key and the next black key to the left of it to create a minor (min) chord. 

• Press one key and both the next black and white key to the left of it to create a minor 
seventh (min7) chord. 

 



 

66 

 

Phrase Player 
 

 
 
The Phrase Player utilizes short MIDI sequences called phrases and fills for various 
instrument categories and in a variety of musical styles. These phrases and fills are more 
complex than Chord Player phrases. Phrases and fills are played by pressing one key at a 
time.  
 
In contrast to the Chord Player where you use the Octave knob to select an octave for 
defining the pitch of the accompaniment, Phrase Player lets you use all octaves keys 
above the C1 octave for pitch selection. 
 
To activate the Phrase Player: 

1. Make sure you have selected the desired instrument patch in the Instrument Bar. 

2. In the Play Tab, set the Players switch to on and drag the mode switch handle to 
Phrase. 

 
Note: All instruments can be used with the Phrase Player. 
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Playing Style & Musical Style Local Menus 
 
The Playing Style is automatically set to default 
to the instrument family of the selected 
instrument. A Musical Style is also set by 
default. You can change either of these two 
settings as described in Playing Style & 
Musical Style Menus in the Chord Player 
section. 
 
Phrase and Fill Keys 
 
Each musical style contains seven phrases and 
five fills. Fills are introductory, intermediate, or 
ending phrases. Phrases and fills can be 
selected using the keys in the C1 octave of 
your controller keyboard or on the on-screen 
keyboard in the Players section. On the on-
screen keyboard, the phrase and fill keys are marked by different colors. 
 
Creating Phrase Accompaniment 
 
Audition the available phrases and fills by individually pressing each key in the C1 octave. 
The phrase and fill keys are only used for selecting any of the available phrases and fills, 
not for changing the root note of the phrase. Available phrases are played based on the 
last note played. For example, if C were last note played, all of the phrases would be 
based on C.  
 
To select a phrase or fill, press a key in the C1 octave of your keyboard controller or 
click the corresponding Phrase key on the on-screen keyboard. Now press one key only 
in the desired octave to start phrase or fill playback. 
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Playback stops immediately when you let go of the key. Playback continues with another 
pitch when you press other keys, and you can, of course, select other phrases or fills 
during playback. 
 
It is useful to get acquainted with the different lengths of the available fills before you 
actually use them. This helps you in finding a rhythmically appropriate triggering point. 
 
Move to Key Signature 
 
You can let the Phrase Player automatically adjust the phrases and fills you play to the key 
signature of the Session.  
 
Select a global scale in the Key Signature local menus on the Control Bar. Find more 
information in Key Signature. 
 
To enable, set Move to Key Signature to On.  
 
The Phrase Player will now create diatonically correct major or minor phrases according to 
the selected key signature. 
 
Root Display 
 
This display shows the root key of the currently played phrase. 
 
 
Feel Knob 
 
Using this rotary control, you determine the degree to which the velocity 
values of individual keys within a phrase or fill are randomized to create a 
more natural, human playing style. The velocity differences within the phrase 
increase the more you turn this knob up. 
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Speed Knob 
 
The speed knob is used to determine the playback speed of the current 
phrase accompaniment. Three speed settings are available: Normal, Half, 
and Double. To set playback speed, click the knob and drag upwards or 
downwards to the desired setting. 
 

Velocity Switch & Intensity Knob 
 
Usually, the velocity with which you hit keys on your keyboard 
controller has an effect on how the corresponding note, chord, or 
phrase sounds. The harder you hit, the more accentuated the 
resulting sound will be. 
 
• If the Velocity switch is On, the phrase will react to the play velocity as described 

above. What actually happens is that the various pre-programmed velocity values 
inside the phrase will be increased or decreased accordingly, resulting in a 
corresponding sound. 

• If the Velocity switch is Off, the velocity settings incorporated in the selected phrase 
will not be increased or decreased by external velocity data; no matter how hard you 
hit a key on your controller, it will have the same velocity. 

• The Intensity knob adds or deducts an offset value to/from the velocity values that 
have been programmed into the phrase. It can thus be used to set a "fixed" velocity 
level that still incorporates the different velocities inherent in the phrase. Note that 
you must set the Velocity switch to off to achieve this. 

 
Important: 
• Depending on the instrument type used, increasing the Intensity value to the 

maximum sometimes seems to add additional elements to the phrase. One example 
of this is the Drums style Dance A 125 4 On The Floor. The additional Toms you 
hear at the maximum Intensity setting have always been part of the phrase, but will 
be clearly audible only now. 

• These two controls are only available in Phrase mode. 
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Arpeggiator 
 

 
 
An arpeggio is a chord whose individual notes are played sequentially (one after the other, 
not simultaneously). This player lets you create a variety of arpeggios and can also be 
used to play chords in a very precise, rhythmic fashion.  
 
To create an arpeggio with the Arpeggiator:  

1. Select the desired instrument in the Instrument Bar. 

2. Set the Players switch to on and drag the Mode switch handle to Arp. 

3. Use the Speed knob to select a note value for all notes in the arpeggio you are about 
to play. (The Speed knob is described in Speed.) 

4. Use the Type knob to select the kind of arpeggio you wish to create. (The Type knob 
is described in Type. 

5. Use the Octave knob to select an octave range in which the arpeggio should take 
place (e.g., select 4, then the chord you press will be arpeggiated once in each 
octave before it returns to the original octave where the cycle starts again). 

Using the Octave knob can also create interesting results when you use it with the 
Shape knob set to Chord and the Speed knob set to a smaller note value. 
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Move to Key Signature 
 
The arpeggio can follow the global key signature of the Session. Select a global scale in 
the Key Signature local menus on the Control Bar. Find more information in Key 
Signature. 
 
To enable, set Move to Key Signature to On.  
 
The Arpeggiator will now create diatonically correct major or minor arpeggios according to 
the selected key signature. 
 
Speed 
 
In this mode, you can use the Speed knob to select a common note value for 
all notes played within the arpeggio. You can select the even, dotted, and 
triplet variants of note values between a quarter-note and a thirty-second-
note. 
 
Click the knob and drag upward or downward to select a note value. 
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Type 
 
You can use this rotary control to select one of the available arpeggio types. 
 
Click the knob and drag upward or downward to select an arpeggio shape. 
 
The following arpeggios shapes are available: 

• Up: An arpeggio where all notes in the chord are played in ascending order. 

• Down: An arpeggio where all notes in the chord are played in descending order. 

• Up and Down: An arpeggio where all notes in the chord are first played in ascending 
then in descending order, but the start and end note occur only once. 

• Up then Down: An arpeggio where all notes in the chord are first played in ascending 
and then in descending order, but the start and end note occur twice. Here, 
ascending and descending order are understood as two separate entities. 

• Play Order: An arpeggio where the notes in the chord are played in the same order 
that you used when pressing the individual keys of the chord. 

• Random: An arpeggio whose notes in the chord are triggered in a random fashion, 
as the name implies. 

• Chord: No arpeggio, but rather rhythmically very precise chords. 
 
Octave 
 
This rotary control in Arpeggiator lets you define the number of octaves in 
which the arpeggio is being repeated before it returns to its starting point. 
Click the knob and drag upward or downward to select the number of 
octaves. 
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Edit Tab 
 
The Edit Tab will provide you with the ability to edit either MIDI or Audio, depending on 
the clip you have selected in the arranger. 
 
Ignite includes a Piano Roll Editor for MIDI and a Wave Editor for audio. You will see either 
the Piano Roll Editor or Audio Wave editor in the Edit Tab, depending on the type of clip 
you have selected in the Arranger. 
 
If you have no clip selected in the Arranger you will see the following: 
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Piano Roll Editor 
 
The Piano Roll editor lets you inspect, manually input and edit the note content of the clips 
that you create. The Piano Roll Editor is located in the Edit Tab and is shown automatically 
when a MIDI clip is selected in the Arranger. 
 
Double-click a clip in the Arranger. As an alternative, you can also select a clip in the 
Arranger and click the Edit Tab at the top of the Ignite window. 
 
Note: If you are working with an Audio clip, the Wave Editor will be shown. This is normal. 
 
The Piano Roll editor will become visible in the tab view in the upper half of the Ignite 
window and display the MIDI notes and chords of the selected clip. If nothing has been 
recorded/input yet, the editor will be empty.  
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Overview of Controls in Piano Roll Editor 
 

 
 

Piano Roll Editor in the Edit Tab 
 
In the Piano Roll editor, notes are shown as rectangles in a similar fashion as on a real 
piano roll. The further a note extends to the right, the longer it will sound. The ruler at the 
top of the editor is the timeline. It divides time into bars and beats. It also indicates the 
note value that you select from the Grid menu, which is described in Grid Menu. 
 
There is a vertical keyboard to the left that can also be played to hear the sound used for 
the current clip. The keyboard serves as a reference to the pitch of recorded or manually 
input notes. 
 
The numbers in the Timeline are bar numbers. When a single clip is selected, its bar 
numbers will appear here. When a Multi clip or Song clip is selected, the bar numbers of 
the original clip will appear here. 
 
Overall clip length is indicated by a colored overlay and can be increased or decreased 
manually (see Changing the Length of a MIDI Clip). 
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When you start clip playback, the Now Line indicates the current playback position in the 
Piano Roll View. You can reposition the Now Line by clicking elsewhere in the Timeline. 
 
Using the vertical scroll bar to the far right or a mouse scroll wheel, you can scroll the 
visible pitch range up or down to reveal the higher or lower key ranges of the keyboard 
and the respective notes.  
 
You can also drag the Control Bar downwards to increase the size of the Edit Tab or 
press [F] until the editor occupies the majority of the window. 
 
The horizontal scroll bar can be used to move the visible part of the grid along the 
timeline. 
 
Using the zoom buttons in the bottom right corner of the editor, you can zoom in or out 
horizontally on the editor section. You can also press [Alt] and use a mouse scroll wheel. 
 
Selecting/Deselecting Notes 
 
Selecting or deselecting is done with the pointer tool, described in Editing Tools. 
 
To select a single note, click on its center. Selected notes get a different color. 
 
To select a group of adjacent notes, position the pointer on an empty area next to the 
group, and then click and drag the mouse to select all desired notes.  
 
To select a group of scattered notes, hold down [Shift] on your computer keyboard and 
click on the desired notes, one by one. 
 
To deselect single previously selected notes, hold down [Shift] and click on the 
selected notes that you want to deselect. 
 
To deselect all previously selected notes, click on an empty area within the grid. 
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Grid Menu 
 
This local menu is located at the top right of the editor. To open the grid 
menu, click the downward pointing arrow. 
 
By selecting a note value here, you determine the "resolution" of the 
grid. Each bar is divided by vertical lines that are determined by the 
selected note value and represent the start positions within the bar for 
each note of the selected type.  
 
For example, if the Session is in 4/4 time and if you select 1/2 (half-note), 
you will get two lines for the two half-notes that each bar can 
accommodate. Selecting 1/4 (quarter-note) will create four lines for the 
four possible quarter-notes per bar, etc. The smallest selectable note 
value is sixty-fourth-note triplets. 
 
There is an Auto option on the menu, which is selected by default. This 
lets you change grid resolution by using the editor's zoom buttons. If you zoom in, the 
resolution will automatically change to smaller note values. If you zoom out, the resolution 
will automatically change to higher note values. 
 
The start position of each note behaves as if it were magnetic. When you input notes 
manually, they will start at that exact position, "snapping" to the closest note start. You 
can also move notes freely to other than the grid positions (see Overriding the Grid). 
 
If the grid has the focus, you can toggle between straight and triplet note resolution grid 
by pressing [T] on your computer keyboard. 
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Zooming In and Out of the Grid 
 
Two methods are available for zooming in/out of the Piano Roll View area: 

• Click the small + or – button in the bottom right corner of the Piano Roll editor. To 
zoom continuously, simply hold down the mouse button. 

• Hold [Alt] on your computer keyboard and use a mouse scroll wheel. 
 
Toggling between straight and triplet note grid works here as well. 
 
Aligning MIDI Notes to the Grid 
 
You can use the grid menu setting to correct the positions of recorded notes to the 
nearest exact note start positions after recording. This process is called aligning notes to 
grid. It can be applied to a number of selected notes within a clip or all notes within a clip. 
 
To align notes to the grid: 

1. Select the desired grid resolution in the grid menu. 

2. Select the notes that you wish to align. You can select some or all notes within the 
clip. 

3. Now click the Align Notes to Grid button, located to the right of the grid menu. 
 
If you are not satisfied with the result, you can undo the process by selecting Undo from 
the Edit menu. 

Aligning notes can also be used during recording. A special Auto-Align Notes button and 
its local menu are available on the Control Bar. Auto-aligning notes control is described in 
Auto Align Notes.  
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Overriding the Grid 
 
You can override note alignment and drag notes freely to other positions. To do so, hold 
down [Command] (Mac OS X) or [Ctrl] (Windows), select the notes, and drag them to the 
desired positions. 
 
Editing Tools 
 
In the lower right corner of the Piano Roll editor section, you can select the tools available 
here by clicking on it. You can also use the keyboard shortcuts listed below. 

 
The pointer moves notes forward or backward in time and upwards or 
downwards in pitch. 
 
 
The pencil inputs notes manually. 
 
 
Velocity increases or decreases the speed with which the keyboard key 
(corresponding to the note you edit) should have been played. 
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Using the Pointer to Change a Note's Position or Pitch 
 
When you select this tool, the mouse pointer has an arrow shape and you can 
use the mouse to drag a note to a new time and/or pitch position. 
The currently selected grid value applies, which means that the note will 
automatically be assigned to the nearest note value position within the grid.  
 
To disable this grid alignment: 
1. Select a note you want to move by clicking on its center. 
2. Drag it to the desired position/pitch.  
3. Let go of the mouse button when the note is in desired position/pitch. 

 
To temporarily disable grid alignment as you move a note, press [Command] (Mac OS 
X) or [Ctrl] (Windows) while dragging it. Hold [Shift] as you move notes to confine note 
movement to horizontal or vertical movement. 
 
If clip playback is off, the note you drag will sound while you move it, which gives you a 
clear indication where you move it. 
 
To move a group of notes: 
1. Select the desired notes (described above in Selecting/Deselecting Notes). 
2. Click on the center of any of the selected notes and drag all notes to the desired 

time/pitch position. 
Unless you are overriding the grid (see Overriding the Grid), the currently selected note 
alignment value applies, which means that the note you clicked to drag the group will 
automatically be assigned to the nearest rhythmically correct note value position. 
Important: The relative distance between recorded unaligned notes is kept intact and not 
changed when you move them. 
 
If you are not satisfied with the result, you can undo the process by selecting Undo on the 
Edit menu. 
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Inputting Notes with the Pencil Tool 
 
This tool can be used to input notes manually. When you select it, the mouse 
pointer changes to a pencil shape. 
 
Move the pointer to the position in the grid, where you want to input a note, then click to 
add a note. The input note will get the length that you select from the grid menu, 
described above. By default, it gets a fixed velocity value of 100.  
 
To input a note with a length that exceeds the currently used grid setting, move the pointer 
to the position in the grid, where you want to input the note, then click and drag to the 
right for the desired note length. The resulting note gets the length of a multiple of the 
selected note value. 
 
Clip length is automatically increased when you manually input notes to the right of the 
clip's current length. 
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Editing Velocity 
 
When you play or record music with Ignite using a MIDI keyboard controller, a 
parameter called velocity is recorded along with the notes. Depending on how 
hard you hit the keys on the keyboard, the expression of the sound will change. 
The softer you press a key on your MIDI keyboard controller, the quieter the instrument 
sounds. Conversely, the harder you hit a note on the keyboard, the louder it sounds. 
 
You can use the velocity tool to fine-tune 
velocity for single notes or selected groups of 
notes. When you select the tool and move the 
pointer over a note, the pointer gets a 
distinctive shape. Velocity has a setting range 
from 0 to 127. 
 
To adjust velocity: 

1. With the velocity tool selected, move the 
mouse over the note whose velocity you 
wish to change. 

2. Hold down the mouse button and slowly 
drag the mouse up or down. The velocity 
value changes in increments of 1 and will be shown to help you make the desired 
setting. 

 
The velocity of a note is reflected by the brightness of its color; the brighter the color, the 
higher the set velocity. 
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You can also change the velocity of notes simultaneously. To set velocity for a group of 
notes, select the velocity tool, and select the desired notes by holding down [Shift] on your 
computer keyboard and clicking on the notes with your mouse. The velocity value of these 
notes can now be changed in the same manner as described above.  
 
Important: By changing the velocity value for one of the selected notes, you increase or 
decrease their current velocity value by the same velocity amount.  
 
Example: 

 Original Velocity Added Value Resulting Velocity

 70 10 80 

 80 10 90 

 90 10 100 

 
Changing Note Lengths with the Trim Tool 
 
Using the trim tool, you can change the lengths of single or 
selected groups of notes. 
 
Move the pointer to the right or left rim of the note. The pointer form changes to a square 
bracket (the trim tool). Click and drag the trim tool left or right to decrease or increase note 
length(s). 
 
Duplicating Notes 
 
To duplicate notes, select them first. Then press [Alt] and drag them to a new position. 
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Deleting Notes 
 
You can use one of the following methods to delete single or groups of notes: 

• To delete a single note, double-click it. It doesn't matter which of the available tools 
is selected. 

• To delete a group of notes, select them first, then press [Delete] or [Backspace] on 
your computer keyboard. 

 
Undo and Redo can be used to go back to the previous state or to undo the Undo. 
 
Changing the Length of a MIDI Clip 
 
Clip length can be changed in the Piano Roll view. The minimum resulting clip length 
cannot be smaller than 1 bar. 
 
1. Move the pointer to the left or right rim of the 

clip. The pointer form changes to a square 
bracket (the trim tool). 

2. Click and drag the trim tool left or right to 
adjust the start or end position of the clip. 
Dragging happens smoothly, but the clip 
boundary will snap to the nearest full bar 
position as soon as you let go of the mouse 
button. The changed length is visible both in 
the Piano Roll editor and in the Arranger. 

 
Notes outside the new clip length will not be played back, but are not deleted, as you may 
later want to increase clip size again. "Outside" notes can still be edited. 
 
When you manually input notes to the left or right of the clip's current length, the clip 
length will automatically be increased to include them. Upon playback, the clip will begin 
at its new start position and loop when it reaches its new end position. 
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Repositioning the MIDI Clip 
 
The MIDI clip's position in relation to its content can be adjusted in the Edit Tab. 
 
1. Move the pointer to the Edit Tab timeline. 

2. The pointer form changes to a double-headed arrow (the clip reposition tool). 
 

 
 
3. While holding the [Shift] key, click and drag the clip reposition tool left or right to 

move the entire clip. Dragging happens smoothly, but the clip boundary will snap to 
the nearest full bar position as soon as you let go of the mouse button. 

 
Important: It is not possible to change clip length during playback. 
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Editing Audio 
 

 
 
Changing the Length of an Audio Clip 
 
Audio clip length can be changed in the Edit Tab. The minimum resulting audio clip length 
cannot be smaller than 1 bar. 
 
1. Move the pointer to the left or right rim of the clip. The pointer 

form changes to a square bracket (the trim tool). 

2. Click and drag the trim tool left or right to adjust the start or end 
position of the audio clip. Dragging happens smoothly, but the 
audio clip boundary will snap to the nearest full bar position as 
soon as you let go of the mouse button. The changed length is 
visible both in the Edit Tab and in the Arranger. 

 
Audio outside the new audio clip length will not be played back, but is not deleted as you 
may later want to increase audio clip size again. Upon playback, the clip will begin at its 
new start position and loop when it reaches its new end position. 
 
Important: It is not possible to change clip length during playback. 
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Adjusting the Play Markers 
 
Unwanted noise at the start or end of an audio clip can be silenced using the Play Area 
Markers. 
 
1. Move the pointer to the triangle at the bottom of the 

waveform. The pointer form changes to a double-headed 
arrow (the marker reposition tool). 

2. Click and drag the marker reposition tool left or right to 
decrease or increase the audio clip's length.  

 
Audio to the left of the Play Area Start Marker and right of the 
Play Area End Marker is dimmed and will not be heard. 
 
Repositioning the Waveform 
 
The audio clip's position in relation to the audio can be adjusted by bar or freely in the Edit 
Tab. Free repositioning is useful if, for example, an imported audio file does not start 
precisely on the downbeat. 
 
1. Move the pointer inside the Edit 

Tab timeline. The pointer form 
changes to a double-headed 
arrow (the clip reposition tool). 

2. To move the entire clip relative to the audio by bar, hold down the [Shift] key, click 
and drag the clip reposition tool left or right. Dragging happens smoothly, but the clip 
boundary will snap to the nearest full bar position as soon as you let go of the mouse 
button. 

To move the entire clip freely relative to the audio, hold down the [Shift]+[Ctrl] 
(Windows) or [Shift]+[Command] (Mac OS X) keys, click and drag the clip reposition 
tool left or right. The clip boundary will stay at the position to which it is dragged 
when you let go of the mouse button. 
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Original Tempo 
 
When you record audio into your Session, the resulting audio clip is given the same tempo 
as your Session. For example if you Session tempo is set to 120 BPM, any audio your 
record into the same Session will be set at 120 BPM. 
 
Locking/Unlocking Audio Clips to the Session Tempo 
 
Audio clips can be locked to or unlocked from the session tempo in the Edit Tab. This is 
useful if, for example, an imported audio clip is at a different tempo to the rest of your 
session, or if you want to adjust the tempo later. 
 
To unlock the tempo of a selected audio clip, click on the lock icon. When the tempo of 
a selected audio clip is unlocked, the audio clip will maintain the original tempo and not 
follow any Session tempo changes. 
 
By default, the tempo of recorded audio clips in the current Session is locked. This way, if 
you change the overall tempo of your session, the tempo audio clips will also be changed 
(also called "time-stretched") to match the new tempo of your Session.  

For example, the current tempo of the currently open Session is 120 BPM, and all audio 
clips recorded into the Session are also locked to 120 BPM. When the tempo of the 
Session is changed to, say, 100 BPM, the tempo of the entire project, including all tempo 
locked audio clips, will also change to the new Session tempo. 

 
1. Double-click the Original Tempo field so that the current value is highlighted and 

type in the original tempo of the audio clip. Alternatively, click the tempo value and 
drag up or down with your mouse. 

2. Click the lock icon next to the Original Tempo field to lock to or 
unlock from the session tempo. 


Note: Audio recorded in Ignite is automatically locked to the session 
tempo, but imported audio clips are not. 
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Control Bar 
 
The Control Bar is the area in the center of the Ignite window. It contains elements that let 
you define the basic musical settings for the current Session (tempo, time signature, and 
key signature) as well as the controls you need to start and stop recording or playback of 
clips. Additional control elements on the Control Bar include overwrite/overdub, automatic 
note alignment, and the master volume slider/meter.  
 

 
 

Metronome Button and Volume Control 
 
The metronome button to the far left lets you turn the metronome 
on or off. The click follows the currently selected time signature 
and tempo. It sounds on each beat. The first beat in each bar is 
accentuated by a higher pitched click.  
 
You can use the metronome in a couple of ways: 

• Count-in during recording: Click the record button, and the 
metronome will automatically start playing the count-in. 

• Practice: Simply click the metronome button to start or stop 
it. 

 
You can adjust the metronome volume by clicking and holding the mouse (or right-
clicking) over the metronome button until a slider appears, then adjust the volume higher 
or lower as needed. 
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Tempo 
 
The current tempo of your Session in BPM (beats per minute) is displayed here. Tempo 
can be set in a range between 30 and 350 BPM. 
 
To change the tempo, do one of the following: 

• Double-click the Tempo field so that the current value is highlighted and type in a 
new tempo.  

• Click the tempo value and drag up or down with your mouse. 
 
Important: When changing the Session tempo, be sure all audio clips in the project are 
tempo-locked. See Locking/Unlocking Audio Clips to the Session Tempo for more 
information. 
 
To move the entire clip relative to the audio by bar, hold down the [Shift] key, click and 
drag the clip reposition tool left or right. Dragging happens smoothly, but the clip 
boundary will snap to the nearest full bar position as soon as you let go of the mouse 
button. 

To move the entire clip freely relative to the audio, hold down the [Shift]+[Ctrl] 
(Windows) or [Shift]+[Command] (Mac OS X) keys, click and drag the clip reposition tool 
left or right. 

The clip boundary will stay at the position to which it is dragged when you let go of the 
mouse button. 
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Swing 
 
Swing is a rhythmic style in which note pairs (e.g., two consecutive eighth-notes) are 
played with a differing duration. Music may for example be written in 4/4 but rather be 
played as if it were a 12/8 with the nesting note in each eighth-note triplet remaining silent. 
This creates one of the many possible swing interpretations. 
 

 
"Straight" (not swung) 16th notes in 4/4 

 

 
Swung 16th notes in 4/4 

 
By changing the value in the Swing field, you can add a global swing factor to your whole 
Session. You can change the Swing value by typing, dragging or using the mouse wheel. 
 
Available values range from 0 (no global swing) to 100 (strong global swing).  
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Time Signature 
 
The current time signature is shown here and can be changed if there are no clips in the 
Arranger. The available time signatures are: 2/2, 2/4, 3/4, 4/4, 5/4, 7/4, 5/8, 6/8, 7/8, 9/8, 
and 12/8. 
 
To select another time signature, click on the currently selected one and select a new time 
signature from the local menu. 
 

Key Signature 
 
Ignite supports major and minor key signatures. To change 
the key signature for the currently loaded Session, first 
select the key by clicking on the Key (to the left) and 
selecting a new key from the local menu, then select either 
major or minor (to the right) by clicking on Maj. or Min.  
 
Important: New Sessions default to C Major, and the 
selected key signature is saved with the Session. 
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Transport Controls 
 

 
 

Auto Align Notes 
 
You can use this button and its local menu to automatically correct 
notes to exact positions during recording. This is also called Input 
Quantize. 

By selecting a note value on the local menu, you create an invisible 
grid in each bar that determines the nearest correct note start 
position. Notes you play during recording are then automatically 
placed accordingly. 

Important: Auto Align Notes is on by default but is bypassed when 
using the Players. 
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Setting and Enabling Auto Align Notes 

1. Select the desired note resolution on the local menu of the button: 

2. Position the mouse pointer over the Auto Align Notes button and hold down the 
mouse button. The local menu opens and you can select one of the two available 
resolutions. (If you have a two-button mouse, you can also use the right mouse 
button to open the menu.) 

3. To enable Auto Align Notes, click the button so that its 
symbol turns blue. 

To disable Auto Align Notes, click the button again so that 
its symbol is shown in black. 

  
Stop All Button 
 
Click this button to stop all playback or press the [Space Bar] on your 
computer keyboard. 
 
Ignite's Stop All button is automatically mapped to the [Stop] button on 
supported Akai Professional, Alesis, and M-Audio keyboards. 
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Record Button 
 
This button is used to start and stop recording, as well as selecting from one 
of the three different record modes. To learn more about the recording modes 
in Ignite, see Recording Modes. 
 
To enable recording, click the record button. The button lights up and recording starts as 
soon as you hit the first note during count-in. During recording, the number of bars that 
you record is displayed to the left in the developing clip. 
 
To disable recording, click the record button again. Recording stops immediately and 
everything recorded until the end of the last fully recorded bar is kept. Hanging notes are 
cut off at that bar's end. 
 
Ignite's record button is automatically mapped to the [Record] button on supported Akai 
Professional, Alesis, and M-Audio keyboards. 
 
Important: If you are previewing an instrument when you start recording, that instrument 
will be created automatically when the recording begins. It will retain any edits you have 
made to its parameters while previewing it. 
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Cued Clips Controls 
 
These buttons can be used to start and stop 
playback of several clips, Multi clips or Song clips 
simultaneously. They can only be used when clips 
have automatically or manually been selected for 
cued playback. Find more information in Using 
Cued Clips. 
 
All cued clips start to play back simultaneously when you click the play cued button or hit 
[Space Bar] on your computer keyboard.  
 
Playback can be stopped by clicking the Stop All button or by pressing the [Space Bar] 
again. 
 
If you click the Play Cued clips button, but 
have not yet cued clips, you will see the 
following: 
 
 
 
 
 
Ignite's Cued Clips control is automatically mapped to the [Play] button on supported Akai 
Professional, Alesis, and M-Audio keyboards. 
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Master Output Volume Slider/Meter 
 
The master output volume slider/meter is located 
to the far right on the Control Bar. It is used to 
control the master audio output level during 
playback.  
 
The meter features an LED-type display with different colors to indicate the low/mid/high 
level stages. There is a Peak indicator that will display for three seconds. 
 
A clipping indicator is also available. If the two single LEDs to the right in the meter light 
up, the signal has exceeded the maximum level and thereby caused clipping. You can 
reset this indicator by clicking on it. Clipping means that the signal peaks are cut off once 
they exceed the maximum level.  
 
Important: Clipping may distort the output sound. 
 
Ignite's master volume can be adjusted using the following M-Audio keyboards: 

• M-Audio Axiom AIR 49 or Axiom AIR 61: Fader [9]. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: Faders [F9]. 

• M-Audio Axiom 49 or Axiom 61: Fader [F9]. 

• M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: Fader [C9]. 
 
Master Output Limiter 
 
When you enable this button by clicking on it, the master output level is limited so that 
clipping does not occur. The Limiter button has a red outline when you activate it. A red 
dot in its middle indicates when the Limiter sets in. The brighter red the center becomes, 
the higher the level peaks that the Limiter receives. 
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Instrument Bar 

 
The Instrument Bar is located at the top of the Arranger. It contains all instruments in the 
currently open Session.  
 
An instrument and all clips that you have recorded with it are connected: 

• If you click a clip, the corresponding instrument will be selected in the Instrument 
Bar. 

• If you click an instrument on the Instrument Bar, all clips that have been created with 
it, are selected. 

• Instrument families, selected patches, instrument icons in the Instrument Bar, and the 
clips in the Arranger are the same color. 

 
The Instrument that is selected in the Instrument Bar is the instrument that is currently 
active for playing and recording. It is also the instrument that will be changed when 
making adjustments in Ignite's top panel. 
 
When a Clip is selected in the Arranger, the Instrument to which it belongs is also 
automatically selected. 
 

Scrolling and Reordering Instruments 
 
If you have many instruments in a Session, and they are not visible in the Instrument Bar, 
use the left or right arrows to display instruments that are off screen. 
Tip: You can reorder your instruments by clicking and dragging instrument icons to new 
locations in the Instrument Bar. 
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Assigning Clips to Different Instruments  
 
This function lets you change the instrument that is used when playing back a clip.  
 
1. When you click on an Instrument in the Instrument Bar and hold the mouse down 

without moving it, a "ghost" Instrument appears. 

2. With the "ghost" Instrument visible, drag to any clip in the Arranger. 

3. Release the mouse button, and the clip will be re-assigned to the instrument that you 
dragged it to. If the Instrument belongs to a different family, the clip color will change 
to reflect this. 

 
Important: Audio clips can only be assigned to Audio Instruments, and Instrument clips 
can only be assigned to non-Audio Instruments. 
 

Banking for Supported Keyboard Controllers 
 
If a supported Akai Professional, Alesis, M-Audio keyboard is connected to Ignite, an 
orange box is shown around the group of instruments that the volume and pan controls on 
the keyboard are currently adjusting – this is referred to in Ignite as a "bank." 
 

 
 
The bank will automatically switch to include the currently selected instrument. The 
number of instruments in a bank is determined by the number of controls on the 
connected keyboard. 



 

100 

 
Using Shortcuts in the Instrument Bar 
 

For a full list of keyboard shortcuts in the Instrument Bar, see Keyboard Shortcuts. 
 
When the Instrument Bar has focus (see Focus), it can be navigated using the following Akai 
Professional and M-Audio keyboards: 

• Akai Professional MAX49: Drum Pad Bank D Pads [5/7]-Previous/Next Instrument, [12/4]-
Previous/Next Bank, [2/10] and Fader Buttons [9-16]-Show/Hide Fader. 

• Akai Professional MAX25: Drum Pad Bank D Pads [3/4]-Previous/Next Instrument, [2/1] and 
Fader Buttons [9-12]-Show/Hide Fader. 

• Akai Professional MPK61 or MPK88: Drum Pad Bank D Pads [5/7]-Previous/Next Instrument, 
[12/4]-Previous/Next Bank, [2/10] and Fader Buttons Bank A [S1-S8]-Show/Hide Fader. 

• Akai Professional MPK49: Drum Pad Bank D Pads [4/6]-Previous/Next Instrument, [12/10]-
Previous/Next Bank, [2/8] and Fader Buttons Bank A [S1-S8]-Show/Hide Fader. 

• Akai Professional MPK25: Drum Pad Bank D Pads [4/6]-Previous/Next Instrument, [12/10]-
Previous/Next Bank, [2/8]-Show/Hide Fader. 

• M-Audio Axiom AIR 49 or Axiom AIR 61: [Left/Right]-Previous/Next Instrument, 
[Bank]+[Left/Right]-Previous/Next Bank, [Down/Up] and Fader Buttons [1-8 Green]-Show/Hide 
Fader. Press [SELECT TRACK] to switch the Fader Buttons between Show/Hide (Green), Mute 
(Red) and Solo (Yellow). 

• M-Audio Axiom AIR 25: [Left/Right]-Previous/Next Instrument, [Bank]+[Left/Right]-Previous/Next 
Bank, [Down/Up]-Show/Hide Fader. 

• M-Audio Axiom AIR Mini 32: [Left/Right]-Previous/Next Instrument, [Enter]+[Left/Right]-
Previous/Next Bank, [Down/Up]-Show/Hide Fader. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric Keypad 4/6]-Previous/Next Instrument, 
[F7/F6]-Previous/Next Bank, [8/2] and Fader Buttons [S1-S8]-Show/Hide Fader. Press S9/S18 to 
switch the Fader Buttons between Show/Hide, Mute and Solo. 

• M-Audio Axiom 49 or Axiom 61: [<Track/Track >]-Previous/Next Bank, Fader Buttons [F1-F8]-
Show/Hide Volume, Fader Buttons. Press F9/F18 to switch the Fader Buttons between 
Show/Hide, Mute and Solo. 

• M-Audio Axiom 25: [<Track/Track >]-Previous/Next Bank. 

• M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: [<Track/Track >]-Previous/Next Bank, Fader 
Buttons [C1-C8]-Show/Hide Volume. 

• M-Audio Oxygen 25: [<Track/Track >]-Previous/Next Instrument. 
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Volume, Pan, Mute, Solo and Additional Controls (Fader) 
 
A volume slider with additional 
controls is available for each 
instrument used in the Session by 
clicking on the small slider icon 
located in the lower right hand 
corner of the instrument icon in the 
Instrument Bar.  
 
You can view all volume sliders by 
clicking on the Show/Hide all 
Volume Sliders icon located to the 
left of the Instrument Bar.  
 
 
 
 
Instrument Name 
 
By default, this shows the name of the Instrument selected in the Choose Tab. To change 
the name, double-click it, type the new name, and press [Return]. If the name has been 
manually changed, it will be retained even if the instrument is replaced via the Choose 
Tab. 
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Instrument Volume Control 
 
The volume slider allows you to control the level of the instrument. The current level is 
displayed above in decibels (dB). 
 
An instrument's volume can be adjusted using the following Akai Professional, Alesis, and 
M-Audio keyboards. 

• Akai Professional MAX49: Faders [9-16]. 

• Akai Professional MAX25: Faders [9-12]. 

• Akai Professional MPK49, MPK61, or MPK88: Faders Bank A/B/C [F1-F8].

• Akai Professional MPK25: Knobs Bank B [1-12]. 

• Alesis QX49 or QX61: Faders [S1-S8]. 

• M-Audio Axiom AIR 49 or Axiom AIR 61: Faders [1-8]. 

• M-Audio Axiom AIR 25: Fader. 

• M-Audio Axiom AIR Mini 32: Knobs [1-8] in Volume mode. To set the mode to 
Volume, press the HyperControl button until the LED next to "Volume" is lit. 

• M-Audio Axiom Pro 49 or Axiom Pro 61: Faders [F1-F8]. 

• M-Audio Axiom Pro 25: Knobs [E1-E8] with [F1-F4] button lit. 

• M-Audio Axiom 49 or Axiom 61: Faders [F1-F8]. 

• M-Audio Axiom 25: Fader. 

• M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: Faders [C1-C8]. 

• M-Audio Oxygen 25: Fader [C9]. 

• M-Audio Venom: Knobs Bank E [1-2]. 

• M-Audio Keystation Mini 32, Keystation 49es, KeyRig 49, KeyStudio: Fader / 
Knob. 
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Pan 
 
The pan knob lets you set the position of the sound within the stereo panorama. "C" 
indicates the center position. 
 
An instrument's pan position can be adjusted using the following Akai Professional and M-
Audio keyboards. 

• Akai Professional MAX49: Faders [17-24]. 

• Akai Professional MAX25: Faders [13-16]. 

• Akai Professional MPK49, MPK61, or MPK88: Knobs Bank B/C [K1-K8].

• M-Audio Axiom AIR 49 or Axiom AIR 61: Knobs with the MIX button next to the 
knobs lit. 

• M-Audio Axiom AIR 25: Knobs with the MIDI button next to the knobs lit. 

• M-Audio Axiom AIR Mini 32: Knobs [1-8] in Pan mode. To set the mode to Pan, 
press the HyperControl button until the LED next to "Pan" is lit. 

• M-Audio Venom: Knobs Bank F [1-2]. 
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Mute and Solo 
 
Using the two buttons below pan, you can mute the instrument and all related clips (Mute) 
or solo the instrument and all related clips (Solo). 
 
Tips:  

• Soloing an instrument will put it into focus, allowing you to further edit it more easily. 

• You can also mute individual clips by using the clip mute button (see Clip Controls). 
 
An instrument's Mute and Solo state can be adjusted using the following Akai Professional 
and M-Audio keyboards. 

• Akai Professional MAX49: Fader Buttons [1-8]-Mute, [17-24]-Solo. 

• Akai Professional MAX25: Fader Buttons [1-4]-Mute, [5-8]-Solo. 

• Akai Professional MPK49, MPK61, or MPK88: Fader Buttons Bank B [S1-S8]-Mute, 
Bank C [S1-S8]-Solo. 

• M-Audio Axiom AIR 49 or Axiom AIR 61: Fader Buttons [1-8 Red]-Mute, [1-8 
Yellow]-Solo. Press [Select Track] to switch the Fader Buttons between Show/Hide 
(Green), Mute (Red) and Solo (Yellow). 

• M-Audio Axiom AIR 25: Fader Button [Red]-Mute, [Yellow]-Solo. Press 
[Mute/Solo/Record] to switch the Fader Button between Show/Hide (Green), Mute 
(Red) and Solo (Yellow). 

• M-Audio Axiom Pro 49 or Axiom Pro 61: Fader Buttons [S1-S8]. Press S9/S18 to 
switch the Fader Buttons between Show/Hide, Mute and Solo. 

• M-Audio Axiom Pro 25: [F4]-Solo, [F4] with [F1-F4] button lit-Mute. 

• M-Audio Axiom 49 or Axiom 61: Fader Buttons [F1-F8]. Press F9/F18 to switch the 
Fader Buttons between Show/Hide, Mute and Solo. 

• M-Audio Axiom 25: [Solo], [Mute]. 
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Additional Controls for Audio Instruments 
 
Audio instruments include two additional controls on their 
fader strips. 
 
Software Monitoring 

Clicking on the Software Monitoring button allows you to 
hear your incoming audio through any effects that have 
been added in the Effects Sub-Tab (see Working with 
Effects). 
 
Important: The Effects can be heard, but they will not be 
recorded into the clip. This is useful if you are recording, 
for example, a singer who wants to hear their voice with 
some reverb but you want to make adjustments later. 
 
It is best to only turn Software Monitoring on when 
monitoring through headphones. This ensures that your 
sound will not produce feedback. 
 
Important: If you hear a significant delay when Software 
Monitoring is turned on, try reducing the Buffer Size (see 
Buffer Size). 
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Input Threshold Control 

As with recording a MIDI instrument, Ignite will only start recording when it senses input 
either from your connected Akai Professional, Alesis, or M-Audio keyboard controller, or 
from an audio input source. The Input Threshold Control allows you to determine how 
sensitive the audio input detection is so that if you are recording quiet audio sources, all of 
the recorded audio will be captured. 
 
To raise or lower the Input Threshold, click and hold either of the two lines that appear 
on either side of the meter and drag to the desired position. Raising the level increases the 
input sensitivity, which is useful for recording very quiet audio sources. Lowering the level 
decreases the input sensitivity, which useful for recording noisy audio sources. 
 

Add New Instrument / Change Instrument Patch 
 
Click this button on the Instrument Bar to create a new instrument. A 
new instrument with a piano sound is created on the Instrument Bar.  
 
If you want to change the instrument, select the desired instrument 
family, category and patch in the Sounds Browser, as described in 
Changing Instruments. 
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Recording  
 
You can record both MIDI and Audio clips in Ignite. The process is about the same for 
both, with some additional steps for recording audio.  
 
Ignite's master tempo can be used to control certain Akai Professional keyboard 
controllers: 
 
Note: The keyboard controller's MIDI Clock must be set to External in order to 
synchronize with Ignite's tempo. 
 
Akai Professional MAX25, MAX49, MPK25, or MPK49: 

• The arpeggiator and sequencer will synchronize with Ignite during recording. 

• When the arpeggiator or sequencer are activated, MIDI input will work only during 
recording. 

• Ignite's tempo can be changed only when it is not recording. 
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Recording Instruments 
 
1. Select the instrument you would like to record a musical idea with from the available 

instruments in the Instrument Bar by clicking on the desired instrument with your 
mouse. 

Important: If you are previewing an instrument when you start recording, that 
instrument will be created automatically when the recording begins. It will retain any 
edits you have made to its parameters while previewing it. 

Tip: For information about creating and editing instrument sounds see, Selecting an 
Instrument Sound and Editing Instrument Sounds. 

 
2. When you are ready to record, click the Record button in the center of the Control 

Bar.  

• If this is the first clip you are recording in a new Session, you will hear the 
metronome count-in, and a count-in appear on your screen until you begin 
playing 

• If you already have clips recorded into the currently open Session, you will hear 
the metronome count-in, and a one-measure count in will appear on your 
screen. Recording will begin at the end of the count-in measure. 

 
3. To stop recording, click the Stop All button in the Control Bar or press [Space Bar] 

on your computer keyboard. The recorded clip is shown in the Arranger. 
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Recording Audio 
 
Recording audio generally follows the same steps above.  
 
1. Open the Home View and select Audio Setup. 

2. Select the input device you would like to use for 
recording audio by clicking on the desired input. 

3. Select if you want to record a mono or stereo 
input: 

4. If you select Stereo, both left and right (or inputs 
1 and 2) inputs will be recorded into a single clip. 

If you selected Mono input, click on the local 
menu of the selected input device to select the 
input you want to record. 

Note: Ignite can record up to two inputs of audio 
only. 

5. Check the input level by playing your instrument 
or speaking into the microphone (whichever you 
are recording). 

6. Close the Home View when you have finished 
making your settings. 

7. Select an Audio Instrument (see Working with 
Audio Instrument Presets). 

8. Locate the added audio instrument preset in the Instrument Bar and open the fader 
to adjust the input threshold, if needed (see Input Threshold Control). 
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9. When you are ready to record, click the Record button in the center of the Control 

Bar. 

10. If this is the first clip you are recording in a new Session, you will hear the metronome 
count-in, and a count-in appear on your screen until you begin playing 

If you already have clips recorded into the currently open Session, you will hear the 
metronome count-in, and a one-measure count in will appear on your screen. 
Recording will begin at the end of the count-in measure. 

11. To stop recording, click the Stop All button in the Control Bar or press [Space Bar] 
on your computer keyboard. The recorded clip is shown in the Arranger. 

 
Recording Modes 
 
Typically, each time you record your performance in Ignite, a new clip is created in the 
Arranger. Ignite includes two additional modes that are useful for other types of recording: 
 
• Record a New Clip is the default mode 

for Recording, where a new clip is created 
each time you record. 

• Replace the Selected Clip's Content is a 
Recording mode you can use when you 
want to complete replace ("record over") 
the currently selected clip. 

• Add to Selected Clip's Content is a Recording mode you can use when you record 
more notes to a currently selected clip. 

 
Position the mouse pointer over the Record button and hold down the mouse button. The 
local menu opens and you can select one of the three available recording modes. If you 
have a two-button mouse, you can also use the right mouse button to open the menu. 
 
Note: These Record Modes are for MIDI clips only. Replace the Selected clip's Content 
and Add to Selected Clip's Content will not work with audio clips. 
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Using Replace the Selected Clip's Content Mode 

1. Select the clip you want to use in the 
Arranger. 

2. Select Replace Clip Content from the 
local menu and click the button to enable 
the record mode. 

3. Click the Record button. The content of 
the current clip is deleted and you get a visible and audible count-in. 

4. Start recording new clip content. 

5. The clip will retain its original length and will loop. 

Note: During recording in overwrite mode, all previously recorded content of the clip 
will be deleted as soon as the loop starts again, which lets you start with a clean 
slate. 

 
 
Using Add Notes to Clip Mode 

1. Select the clip you want to use. 

2. Select Add Notes to Clip from the local 
menu and click the button to enable the 
record mode. 

3. Click the Record button. You will get a 
visible and audible count-in. 

4. Start recording additional clip content. The clip content will loop and you can add 
additional notes on each pass until you stop recording. Clip length remains 
unchanged. If the clip is already playing back when you click the Record button, you 
will only get an on-screen count-in but no metronome sound. 



 

112 

 

Working with Clips and the Arranger 
 
The Arranger is located in the lower half of the Ignite window. It has two sections: the 
Instrument Bar at the top of the Arranger and the Arranger pane. This is where the 
recorded clips are shown.  

The Arranger can be used both as an idea pool and as a workbench where you create 
your arrangement by recording, arranging and grouping clips for separate or synchronized 
playback.  
 

Types of Clips 
 

 
Arranger shown maximized with examples of clips, Multi clips and Song clip 
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A clip is a container for your recorded performance. In other words, it contains the audio 
or notes that you have either recorded or, in the case of MIDI, manually input via the Piano 
Roll editor. 
 
For MIDI clips, a clip also contains MIDI performance data such as velocity (how hard or 
fast you play the keys on your keyboard), pitch bend (a continuous pitch change that you 
introduce by using the pitch bend wheel) and modulation (generated by using the 
modulation wheel on your keyboard). For basic information about MIDI data, see Basic 
Concepts. 
  
Ignite contains three basic types of clips:  

• Individual clip: Notes and performance data recorded for one instrument. 

• Multi clip: Several individual clips that you have grouped manually (see Creating 
Multi Clips). 

• Song clip: Several Multi clips, grouped manually (see Creating Song Clips). 
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Clip Controls 
 

 
Arranger shown maximized with clip, Multi clip and Song clip controls identified. 

 
Play 
 
Ignite provides a number of different playback methods for playing back individual, Multi, 
or Song clips. For more information see, Playing Clips, Multi Clips, and Song Clips. 
 
A clip's Play button can be switched using the [Loop] button on supported Akai 
Professional, Alesis, and M-Audio keyboards. 
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Mute 
 
Each individual clip, Multi clip, or Song clip can be muted. To mute a clip, click its Mute 
button located at the top right. 
 
Individual clips show this when you move the mouse cursor on top of them. Multi and 
Song clips have a common Mute button for muting all contained clips. 
 
Tip: Individual clips contained in Multi clips can be muted. 
 
Delete 
 
Each individual clip, Multi clip, or Song clip can be deleted. To delete a clip, click its 
Delete button located at the top right. 
 
Individual clips show this when you move the mouse cursor on top of them. Multi and 
Song clips have a common Delete button for deleting all contained clips. 
 
Tip: Individual clips contained in Multi clips can still be deleted individually. 
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Creating Multi Clips 
 
Individual clips can be arranged in groups as Multi clips. Multi clips have a common 
play/stop button and common mute and delete buttons.  
 
To create a simple Multi clip: 

1. Record two clips using different instruments. Clips can have any length, but for this 
example record clips of the same length. (Selecting an instrument is described in 
Selecting an Instrument Sound and recording is described in Recording 
Instruments.) 

2. Drag any clip to any other clip so that their edges are touching. A white box appears 
indicating that the clips will be grouped to form a Multi clip. Release the mouse to 
confirm. 

 
You have now created a Multi clip with a common header that contains a play/stop, a 
mute, and a delete button. 
 
Arranging the Clips in a Multi Clip 
 
You can change the arrangement of individual clips in the Multi clip. You can move clips 
either horizontally or vertically or re-order and re-arrange. The Multi clip will automatically 
be resized according to the new arrangement. 
 
When placing clips between other clips, the left edge of the clip that you are dragging is 
used to determine the placement when releasing the mouse. An orange horizontal or 
vertical line will show you the direction in which any existing clips will be pushed to make 
space for the new clip. 
 
Note: When you reposition a clip within a Multi clip, it will snap to the nearest full measure 
of the other clips in the Multi clip. 
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Creating Song Clips 
 
You can group Multi clips to create a Song clip, which is useful when you want to arrange 
a more complex song. All principles outlined in the previous paragraphs for creating and 
arranging the content of Multi clips also applies to Song clips. You can also always 
change Multi clips within a Song clip by adding, removing or by repositioning individual 
clips. 
 

Playing Clips, Multi Clips, and Song Clips 
 
Ignite provides two different playback methods for playing back individual, Multi, or Song 
clips. You can manually play individual clips, Multi clips, and Song clips by clicking on 
their individual play buttons or you can enable them to all play together automatically. 
Both methods will be explained in this section. 
 
Manually Playing Back Individual Clips, Multi Clips, and Song Clips 
 
To start play back of an individual clip, Multi clip, or Song clip, click the Play button for 
the desired clip, Multi clip, or Song clip. The clip, Multi clip or Song clip will begin to play 
back and will loop until you stop playback. 
 
To stop play back of an individual clip, Multi clip, or Song clip, click the clip, Multi clip, 
or Song clip Play button again. Playback can also be stopped using the Stop All button 
on the Control Bar, or by pressing [Space Bar] on your computer keyboard. 
 
It is also possible to start several single clips or Multi clips successively by clicking their 
respective Play buttons. Each clip or Multi clip playback will start on the next bar to sync 
with the currently playing clip or Multi clip. You can stop playback of all clips by using the 
Stop button, or by pressing [Space Bar] on your computer keyboard. 
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Using Cued Clips 
 
In Ignite, you can preselect multiple individual, Multi, or Song clips to start playing at the 
same time. This is called Cued Clips playback. This is the default playback mode when 
you record a new part or create a Multi clip or Song clip from individual clips that are in 
this playback mode.  
 
To enable/disable this playback mode for clips, Multi clips, and Song clips: 

1. [Shift]+Click or right-click the play button of each clip that you want to cue for 
playback. The buttons of the selected clips and the play cued clips button in the 
Control Bar will begin to flash slowly. 

2. Start playback by clicking the Play Cued Clips button in the Control Bar. You can 
also press the [Space Bar] on your computer keyboard. 

3. All cued clips will begin to play. 

4. To stop playback, click the Stop All button or press the [Space Bar] again. 
 
Clips are automatically set to this mode: 

• Immediately after a new clip is recorded. 

• When a new clip is created in the Piano Roll Editor. 

• When a cued clip is connected to another clip to create a Multi clip. 

• When the Play Cued state of the second clip does not matter. 

• When a cued Multi clip is connected to another Multi clip to create a Song clip. 



 

119 

 

Now Line 
 
The Now Line is a white vertical line that 
appears in each clip type during playback. It 
indicates the current playback position.  
 
Positioning the Now Line 
 
You can position the Now Line in Multi and Song clips, which lets you define a playback 
start position.  
 
To do this, click the desired playback start position on the Timeline (see Timeline). The 
Now Line will jump to the nearest full bar position and the corresponding bar number will 
light up in green. You can reposition the Now Line by clicking elsewhere in the Timeline. 
 
When you start playback, it will now start from the new position and when you stop 
playback, the Now Line jumps back to this start position. 
 
Important: 

• Setting a playback start position can only be done in one Multi clip/Song clip at a 
time. 

• If you reposition the Now Line for a Multi clip or Song clip, it will override the 
playback start position of an individual clip.  

• Replace Clip Content and Add to Clip Content modes are disabled when you set 
playback start to any other position than Bar 1. 

 

Timeline 
 
When you create a Multi or Song clip, a horizontal timeline will appear just below the 
header. This indicates the start of all bars in the Multi clip and/or Song clip. 
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Renaming Clips 
 
Each clip you record automatically gets the name of the instrument sound patch you used 
while recording it. Multi and Song clips are automatically named Multi clip and Song clip 
when you create them. 
 
To rename a clip, Multi clip, or Song clip: 

1. Double-click its name to select it. 

2. Enter a new name. 

3. Press [Return] on your computer keyboard. 
 

Duplicating Clips and Multi Clips 
 
Clips and Multi Clips in Ignite's Arranger can be duplicated using the computer keyboard 
or mouse.  
 
To duplicate a clip using the computer keyboard, select the clip and press [Ctrl]+[D] 
(Windows) or [Command]+[D] (Mac OS X) on your computer keyboard. The duplicated clip 
will appear to the right of the original clip. 
 
When a single clip is duplicated in this way, a new Multi clip is created containing the 
original and duplicated Clip. When a single Multi clip is duplicated, a new Song clip is 
created containing the original and duplicated Multi clip. 
 
To duplicate a clip or Multi clip using the mouse, press [Alt] and drag the selected clip 
or Multi clip to a new location. If the position is invalid, the mouse cursor will change to a 
no entry sign and the clip or Multi clip will not be duplicated. 
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Looping Individual Clips 
 
This function lets you quickly loop an individual clip in part, fully, or many times. Looping 
clips is handy, when you create an arrangement that contains clips with persistently 
repeated patterns, such as a drum or percussion pattern, an ostinato bass pattern, a 
chord sequence, etc. 
 
1. When you position the mouse pointer over the 

bottom right edge of a clip, the pointer changes its 
appearance and becomes a loop symbol.  

2. With the loop symbol visible, click and drag to the right to create one or several 
loops. If the clip you are looping is more than one bar long, you can create a partial 
loop in 1-bar increments. 

 
When you create loops within a Multi clip or Song clip, the Multi clip or Song clip container 
is automatically resized, if necessary. 
 
Important: 

• Editing the content of the original clip will also change the content of its loops.  

• When you trim the original clip, the loops will be trimmed as well. 
 
Shortening and lengthening a clip without looping its content can be done in the Piano 
Roll editor (see Changing the Length of a MIDI Clip). 
 
You can use Undo and Redo when using this function. 



 

122 

 

Assigning Clips to Different Instruments  
 
To change the instrument that is used when playing back a clip: 

1. Click a clip and hold the mouse down without moving it. A "ghost" clip appears. 

2. With the "ghost" clip visible, drag to any Instrument in the Instrument Bar. 

3. When the mouse is released, the clip will be re-assigned to the instrument that you 
dragged it to. If the instrument belongs to a different family, the clip color will change 
to reflect this. 

 
Important: Audio clips can only be assigned to Audio Instruments indicated by a 
waveform, and Instrument clips can only be assigned to non-Audio Instruments. 
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Exporting and Sharing Your Music 
 
Ignite offers various ways for you to export and share your music with other people, or 
transfer it for further use in a Digital Audio Workstation (DAW). All of this can be done in 
Ignite's Share Tab, which lets you: 
 
• Share your Session file with a friend via e-mail. 

• Create an audio file of your music. 

• Export your music as a MIDI file to use with another DAW. 

• Directly share your music on SoundCloud and—via this platform—also on other 
social network platforms. 

 
To open the Sharing Tab, click the Share Tab icon on the top right of the Tab Bar. 
 

 
 
Important: Exporting and sharing options work on one selected clip (individual, Multi, or 
Song clip) at a time. If you want to share your complete Session, create a complete 
arrangement inside one Multi or Song clip, before you share it (see Recording). 
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Sharing on SoundCloud  
 
SoundCloud is a free online service that allows registered users to post and 
share songs with friends and family online. You can post your music to 
popular online social networks directly from Ignite to your SoundCloud 
account. To learn more about SoundCloud, visit soundcloud.com. 
 
Important: You must have an active Internet connection in order to use this feature in 
Ignite. 
 
To begin sharing, simply click on the SoundCloud icon in the Share Tab. You will need 
to connect Ignite to your SoundCloud account by logging in, or creating, your SoundCloud 
account. Click the Continue button to proceed. 
 
Connecting to Your SoundCloud Account 
 
If you already have a SoundCloud account, all you 
have to do is log in to your account to connect when 
prompted.  
 
If you do not have a SoundCloud account, and would 
like to sign up, click on the Sign Up tab. 
 
 
 
 
Why do I need to sign into my SoundCloud account through Ignite? 
 
By signing in, Ignite can directly upload your music to your SoundCloud account. Your e-
mail address will be kept private and you can disconnect Ignite in your SoundCloud 
account settings or by clicking the Log Out button in any of Ignite's SoundCloud pages. 

www.soundcloud.com
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Track Info, Tags, File Type, and Sharing on Social Media 
 

 
 
After you login to your SoundCloud account and select the clip, Multi clip, or Song clip 
from the currently open Session you want to share, you will see the above appear in the 
Share Tab. 
 
Track Information 

• Title: Enter the title you want to use for the track you are uploading. You must enter a 
title in order to upload to SoundCloud. 

• Tags: Enter the tags you would like to use to describe your track. Tags also help 
other SoundCloud members find and discover music. Tags are optional. 

• License: Specify the license for the track. The default setting is No Rights Reserved. 
 
File Quality 

You can choose WAV 44.1kHz 16-bit or WAV 48kHz 24-bit. 
 
Social Network Options 

When you upload a track to SoundCloud you can choose to also send automatic "push" 
notifications to your other linked social media accounts. You must configure these settings 
using the account management tools at soundcloud.com first before being able to share 
on these and other social networks. 

www.soundcloud.com
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Once you have configured your social networks, you can choose to automatically publish 
your track from Ignite to those other networks via SoundCloud. 
 
Note: To share your track on social networks, you must make your track "public." If you 
choose to make your track private by selecting the Private option, it will not post to your 
selected social networks. 
 
Uploading Your Track 

After you have entered your information and selected your options, click Continue. The 
selected clip, Multi clip or Song clip will be bounced and uploaded to SoundCloud. You 
will be notified once the upload has completed. 
 
Note: WAV files can be quite large. Depending on your internet connection, the upload 
may take several minutes.  
 
Note: After uploading, it may take a few minutes for your song to be available. If you don't 
see your song appear on SoundCloud or selected social networks right away, wait a few 
minutes for the file to be processed by SoundCloud and try again. 
 

Export an Audio File 
 
To export an audio file from the currently open Session: 

1. Select the Audio option by clicking on its icon.  

2. You will be asked to select a clip, Multi clip, or Song clip in the 
Arranger. Select the desired clip and click Continue.  

3. The next page opens in the browser where you can select the 
quality of the file that you will create and add a title. When you have done so, click 
the Continue button. 

4. A standard Save dialog appears, where you can save the resulting audio file. 
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Export for DAW 
 
Use this option to export a folder containing a separate audio file for 
each Instrument. This is useful if you want to take the audio output of 
your Session and continue working in a traditional digital audio 
workstation. 
 
1. Select the DAW option by clicking on its icon. You will be asked to 

select a clip, Multi clip, or Song clip in the Arranger. 

2. Select the desired clip and click Continue.  

3. The next page opens in the browser where you can select the quality of the files that 
you will create. When you have done so, click the Continue button. 

4. A standard Save dialog appears, where you can save the resulting folder of audio 
files. The folder will be named using the format YY_MM_DD_HHMM Session Name 
Stems and will also include a text file containing the Session name, tempo, time 
signature, and key signature. 

 
To import the files into your DAW, refer to the software's documentation. 
 

Export a MIDI File 
 
To create a MIDI file: 

1. Select the MIDI option by clicking on its icon. 

2. You will be asked to select a clip, Multi clip, or Song clip in the 
Arranger. Select the desired clip and click Continue. 

3. A standard Save dialog appears, where you can save the resulting 
MIDI file. 

 
Important: Only MIDI clips can be exported as MID files.  
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Sharing via E-Mail 
 
Note: If you do not have an e-mail application installed on your 
computer, a message will appear on the screen. 
 
To send the currently open Session via e-mail from Ignite: 

1. Select the E-Mail option by clicking on its icon. 

2. Click Continue. 

3. A Save As… dialog box will appear, prompting you to save the Session. Name your 
Session, choose the location you would like to save it, and click Save. 

4. Your default e-mail client will automatically launch (if not already open), and a new e-
mail message will be created with the recently saved Ignite Session file attached. 

5. Enter the e-mail address of the person(s) you want to send the Session to and 
complete the rest of the e-mail.  

6. Send the e-mail. 
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Tempo-Sync 
 

Where required, Ignite automatically synchronizes with certain Akai Professional keyboard 
controllers to ensure that additional hardware features can be used. 

• Akai Professional MAX25 and MAX49: Pad Roll, Sequencer, and Arpeggiator 

• Akai Professional MPK25, MPK49, MPK61, and MPK88: Pad Roll and Arpeggiator 
For more information on these features, refer to the documentation that came with your 
keyboard controller. 
 

MIDI Learn 
 

When using a hardware controller that Ignite does not recognize, its controls may not be 
mapped to the expected features. In this case, you can use Ignite's MIDI Learn feature to 
manually assign your hardware controls to specific "learnable" software commands—
particularly in the Shape Tab, Play Tab, or certain transport controls in the Control Bar. 
Ignite will recognize these assignments each time you use that hardware controller in 
future sessions. 
Note: This is not possible for hardware controllers that Ignite already recognizes. These 
hardware controllers have pre-defined assignments. 
 
To assign a knob or button: 
1. Right-click a "learnable" knob or button in Ignite. When it turns 

red, it can then be learned by a hardware control. 
2. On your hardware controller, move the desired knob left and 

right, or push the desired button. The knob or button from Step 1 
is now mapped to this hardware control. 
Note: When moving a knob, we recommend moving it between its minimum and 
center positions to ensure Ignite "scans" it accurately. 
To cancel the operation instead, either right-click the learnable knob or button in 
Ignite or press the [Esc] button.  
To reassign the control, just repeat Steps 1-2. 
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To reset all MIDI Learn assignments: 

1. Click the Edit menu in the Menu Bar. 

2. Select Reset MIDI Mapping. 

3. When prompted, confirm or cancel the operation. 

 
For reference, here are the default CC values of the learnable Ignite functions: 
 

Knobs 1-8 CC #17-24 

Master Volume CC #7 

Stop  CC #116 

Play  CC #117 

Record  CC #118 
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Basic Concepts 
 
Using Ignite, you can record MIDI data. Here's a short introduction of this data type and 
related technologies that are used in Ignite. If you know about them already, you can skip 
this section. 
 

MIDI Data 
 
MIDI is an abbreviation for Musical Instrument Digital Interface and a standard 
communication protocol that enables communication between a great variety of musical 
instruments, controllers, computers, mixers, etc.  
 
MIDI devices send and/or receive MIDI Event messages that can contain a wide variety of 
different information.  
 
The MIDI data you create when you play your keyboard and record your play with Ignite 
will contain information about which key you have pressed on your keyboard, when you 
did that during the recording, how long you did it and with what amount of force, etc. 
 
MIDI can create and transport much more data than that. If the connected devices support 
it, MIDI can transfer data about volume, stereo panorama position, used sound patch, 
vibrato, velocity, pitch bend, and much more. 
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Note Alignment 
 
Note Alignment (sometimes also called quantization) is a process that lets you 
automatically correct recorded or manually input MIDI notes to exact rhythmic positions. 
This is done by introducing a "magnetic" grid. The width can be set to a variety of 
commonly used even or triplet note values. The actual alignment process can either occur 
during recording (called "auto-alignment") or at any other time. 
 
In both cases, you select a note value on the respective local menu and thus determine 
the "resolution" of the grid. As a result, each bar is divided by vertical lines (also visible in 
the Piano Roll editor). These represent all available rhythmically correct start positions 
within the bar for each possible note of the selected type. If you select 1/2 (half-note), you 
will get two lines for the two half-notes that would fit in each bar. Selecting 1/4 (quarter-
note) will create four lines for the four possible quarter-notes per bar, etc.  
 
When note alignment is activated, each available note start position behaves as if it were 
magnetic. Notes that occur somewhere between two of these lines, are automatically 
repositioned to the one nearer to the original note position. 
 
Important: This process can be undone if you apply note alignment after the actual 
recording, but Undo will not be available if you apply auto-alignment during recording as 
this auto-corrects the note positions as they are recorded (i.e., there are no previous note 
positions available). 
 
Depending on your intention and playing style, recording with auto-alignment activated 
can sometimes lead to unintended results. But if you want rock-solid timing, alignment 
may be the tool of your choice. 
 
When you input notes manually, they will automatically start at a rhythmically exact 
position. You can also move notes freely to other than the grid positions (see Overriding 
the Grid). 
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HyperControl 
 
HyperControl is a technology for automatic assignment of recording software controls to 
controller hardware, used in M-Audio keyboards. Hypercontrol automatically assigns the 
available controls (knobs, buttons, sliders, pads) on your M-Audio keyboard to functions in 
your recording or instrument software. Tedious and time-consuming assignment by hand 
is not necessary anymore.  
 
As a two-way communication protocol, HyperControl always updates and synchronizes 
the current status of all assigned software and hardware controls.  
 
If you load a new instrument preset in Ignite, its main editing controls are automatically 
assigned to the controls on the mentioned keyboard hardware and you can start editing 
right away. 
 
Editing can be done both from within the software and from the keyboard's controls and is 
directly visible in Ignite's instrument editor and on the keyboard's display. 
 
HyperControl offers additional functionality. To be able to use it, please read the 
documentation that came with your HyperControl-compatible keyboard. 
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Keyboard Shortcuts  
 
Items marked * refer to these products only: Akai Professional MAX25 and MAX49; Akai 
Professional MPK25, MPK49, MPK61, and MPK88; M-Audio Axiom AIR 25, Axiom AIR 
49, and Axiom AIR 61; M-Audio Axiom AIR Mini 32; M-Audio Axiom Pro 49 and Axiom 
Pro 61. 
 

Action Computer Keyboard 
Command 

Keyboard Controller Command

 

General 

Navigate / Confirm 
Selection 

Up / Down / Left / 
Right / Enter 

Akai Professional MAX49: Drum Pad Bank D 
[10/2/5/7]-Up/Down/Left/Right, [6]-Enter 

Akai Professional MAX25: Drum Pad Bank D 
[1/2/3/4]-Up/Down/Left/Right, [5]-Enter 

Akai Professional MPK61 or MPK88: Drum Pad 
Bank D [10/2/5/7]-Up/Down/Left/Right, [6]-Enter 

Akai Professional MPK25 or MPK49: Drum Pad 
Bank D [8/2/4/6]-Up/Down/Left/Right, [5]-Enter 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: [Up], [Down], [Left], [Right], [Enter] 

M-Audio Axiom AIR Mini 32: [Up], [Down], [Left], 
[Right], [Enter] 

M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric 
Keypad 2/8/4/6]-Up/Down/Left/Right, [Numeric 
Keypad 5]-Enter 

Cancel Selection Esc N/A 

View Home Ctrl+, (Windows) 
Command+, (Mac OS 
X) 

N/A 
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View Choose Tab 1 N/A 

View Shape Tab 2 N/A 

View Play Tab 3 N/A 

View Edit Tab 4 N/A 

Turn Players On / Off Shift+P N/A 

Switch Screen Modes Ctrl+F (Windows) 
Command+F (Mac OS 
X) 

N/A 

Reset Rotary/Fader to 
Default Value 

Alt + Click Rotary 
Control/Fader 

N/A 

Undo Ctrl+Z (Windows) 
Command+Z (Mac OS 
X) 

N/A 

Redo Ctrl+Y (Windows) 
Command+Y (Mac 
OS X) 

N/A 

Switch to Next Focus 
Area 

Tab Akai Professional MAX49: Drum Pad Bank D [1/3] 

Akai Professional MAX25: Drum Pad Bank D [7/8] 

Akai Professional MPK61 or MPK88: Drum Pad 
Bank D [1/3] 

Akai Professional MPK25 or MPK49: Drum Pad 
Bank D [1/3] 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: [Enter]+[Down] 

M-Audio Axiom AIR Mini 32: [Enter]+[Down] 

M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric 
Keypad +] 

M-Audio Axiom Pro 25: [F2/F3] with [F1-F4] lit 
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Switch to Previous 
Focus Area 

Shift+Tab Akai Professional MAX49: Drum Pad Bank D 
[9/11] 

Akai Professional MAX25: Drum Pad Bank D [7/8] 

Akai Professional MPK61 or MPK88: Drum Pad 
Bank D [9/11] 

Akai Professional MPK25 or MPK49: Drum Pad 
Bank D [7/9] 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: [Enter]+[Up] 

M-Audio Axiom AIR Mini 32: [Enter]+[Up] 

M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric 
Keypad -] 

M-Audio Axiom Pro 25: [F3] with [F1-F4] lit 

Create New Instrument N N/A 

Control Bar 

Record R Record 

Switch Record Mode Shift+R N/A 

Start/Stop All 
Playback/Recording 

Space Bar Play / Stop 

Auto Align Notes 
On/Off 

Shift+Q N/A 

Metronome On/Off Shift+M N/A 
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Instrument Bar 

Show / Hide Fader Down / Up Akai Professional MAX49: Drum Pad Bank D 
[2/10] and Fader Buttons [9-16] 

Akai Professional MAX25: Drum Pad Bank D [2/1] 
and Fader Buttons [9-12] 

Akai Professional MPK61 or MPK88: Drum Pad 
Bank D [2/10] and Fader Buttons Bank A [S1-S8]

Akai Professional MPK49: Drum Pad Bank D [2/8] 
and Fader Buttons Bank A [S1-S8] 

Akai Professional MPK25: Drum Pad Bank D [2/8] 

M-Audio Axiom AIR 49 or Axiom AIR 61: 
[Down/Up] and Fader Buttons [1-8 Green] - press 
[SELECT TRACK] to switch the Fader Buttons 
between Show/Hide (Green), Mute (Red) and Solo 
(Yellow) 

M-Audio Axiom AIR 25: [Down/Up] 

M-Audio Axiom AIR Mini 32: [Down/Up] 

M-Audio Axiom Pro 49 or Axiom Pro 61: [Numeric 
Keypad 8/2] and Fader Buttons [S1-S8] - press 
S9/S18 to switch the Fader Buttons between 
Show/Hide, Mute and Solo. 

M-Audio Axiom 49 or Axiom 61: Fader Buttons 
[F1-F8] 

M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: 
Fader Buttons [C1-C8] 

Select Previous / Next 
Instrument 

Left / Right Left/Right* (See General > Navigate) 
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Next / Previous 
Instrument Bank 

N/A Akai Professional MAX49: Drum Pad Bank D 
[12/4] 

Akai Professional MPK61 or MPK88: Drum Pad 
Bank D [12/4]

Akai Professional MPK49: Drum Pad Bank D 
[12/10] 

Akai Professional MPK25: Drum Pad Bank D 
Previous/Next Instrument, [12/10] 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: [Bank]+[Left/Right] 

M-Audio Axiom AIR 25: [Bank]+[Left/Right] 

M-Audio Axiom AIR Mini 32: [Enter]+[Left/Right] 

M-Audio Axiom Pro 49 or Axiom Pro 61: [F7/F6 - 
press S9/S18 to switch the Fader Buttons 
between Show/Hide, Mute and Solo. 

M-Audio Axiom 49 or Axiom 61: [<Track/Track >] 

M-Audio Axiom 25: [<Track/Track >] 

M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: 
[<Track/Track >] 

M-Audio Oxygen 25: [<Track/Track >] 
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Instrument Volume N/A Akai Professional MAX49: Faders [9-16] 

Akai Professional MAX25: Faders [9-12] 

Akai Professional MPK49, MPK61, or MPK88: 
Faders Bank A/B/C [F1-F8]

Akai Professional MPK25: Knobs Bank B [1-12] 

Alesis QX49 or QX61: Faders [S1-S8] 

M-Audio Axiom AIR 49 or Axiom AIR 61: Faders 
[1-8] 

M-Audio Axiom AIR 25: Fader 

M-Audio Axiom AIR Mini 32: Knobs [1-8] in 
Volume mode - to set the mode to Volume, press 
the HyperControl button until the LED next to 
"Volume" is lit 

M-Audio Axiom Pro 49 or Axiom Pro 61: Faders 
[F1-F8] 

M-Audio Axiom Pro 25: Knobs [E1-E8] with [F1-
F4] button lit 

M-Audio Axiom 49 or Axiom 61: Faders [F1-F8] 

M-Audio Axiom 25: Fader 

M-Audio Oxygen 49, Oxygen 61, or Oxygen 88: 
Faders [C1-C8] 

M-Audio Oxygen 25: Fader [C9] 

M-Audio Venom: Knobs Bank E [1-2] 

M-Audio Keystation Mini 32 / Keystation 49es / 
KeyRig 49 / KeyStudio: Fader / Knob 
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Instrument Pan N/A Akai Professional MAX49: Faders [17-24] 

Akai Professional MAX25: Faders [13-16] 

Akai Professional MPK49, MPK61, or MPK88: 
Knobs Bank B/C [K1-K8]

M-Audio Axiom AIR 49 or Axiom AIR 61: Knobs 
with the MIX button next to the knobs lit 

M-Audio Axiom AIR 25: Knobs with the MIDI 
button next to the knobs lit 

M-Audio Axiom AIR Mini 32: Knobs [1-8] in Pan 
mode - to set the mode to Pan, press the 
HyperControl button until the LED next to "Pan" is 
lit 

M-Audio Venom: Knobs Bank F [1-2] 

Mute Instrument N/A Akai Professional MAX49: Fader Buttons [1-8] 

Akai Professional MAX25: Fader Buttons [1-4] 

Akai Professional MPK49, MPK61, or MPK88: 
Fader Buttons Bank B [S1-S8] 

M-Audio Axiom AIR 49 or Axiom AIR 61: Fader 
Buttons [1-8 Red] - Press [SELECT TRACK] to 
switch the Fader Buttons between Show/Hide 
(Green), Mute (Red) and Solo (Yellow) 

M-Audio Axiom AIR 25: Fader Button [Red] - 
Press [MUTE/SOLO/RECORD] to switch the Fader 
Button between Show/Hide (Green), Mute (Red) 
and Solo (Yellow). 

M-Audio Axiom Pro 49 or Axiom Pro 61: Fader 
Buttons [S1-S8] - Press S9/S18 to switch the Fader 
Buttons between Show/Hide, Mute and Solo. 

M-Audio Axiom Pro 25: [F4] with [F1-F4] button lit. 

M-Audio Axiom 49 or Axiom 61: Fader Buttons 
[S1-S8] - Press F9/F18 to switch the Fader Buttons 
between Show/Hide, Mute and Solo. 

M-Audio Axiom 25: [Mute] 
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Solo Instrument N/A Akai Professional MAX49: Fader Buttons 
[17-24] 

Akai Professional MAX25: Fader Buttons [1-
4]-Mute, [5-8]-Solo. 

Akai Professional MPK49, MPK61, or 
MPK88: Fader Buttons Bank B [S1-S8]-Mute, 
Bank C [S1-S8]-Solo. 

M-Audio Axiom AIR 49 or Axiom AIR 61: 
Fader Buttons [1-8 Red]-Mute, [1-8 Yellow]-
Solo. Press [SELECT TRACK] to switch the 
Fader Buttons between Show/Hide (Green), 
Mute (Red) and Solo (Yellow). 

M-Audio Axiom AIR 25: Fader Button 
[Yellow] - Press [MUTE/SOLO/RECORD] to 
switch the Fader Button between Show/Hide 
(Green), Mute (Red) and Solo (Yellow). 

M-Audio Axiom Pro 49 or Axiom Pro 61: 
Fader Buttons [S1-S8]. Press S9/S18 to 
switch the Fader Buttons between 
Show/Hide, Mute and Solo. 

M-Audio Axiom Pro 25: [F4], [F4] with [F1-
F4] button lit-Mute. 

M-Audio Axiom 49 or Axiom 61: Fader 
Buttons [S1-S8] - Press F9/F18 to switch the 
Fader Buttons between Show/Hide, Mute and 
Solo. 

M-Audio Axiom 25: [Solo] 

Cancel All Instrument 
Solo/Mute 

Alt+Click Instrument 
Solo/Mute 

N/A 

Open All Instrument 
Faders 

Ctrl+Shift+M (Windows) 
Command+Shift+M (Mac 
OS X) 

N/A 
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Arranger 

Add clip, Multi clip or Song 
clip to Cued clips Playback 

Shift+Click or Right-Click 
clip, Multi clip or Song clip 
Play Button 

Loop 

Copy Selected Clip or Multi 
Clip 

Ctrl+Drag (Windows) 
Alt+Drag (Mac OS X) 

N/A 

Arranger Gap Closing 
On/Off 

Shift+G N/A 

Zoom In/Out Ctrl+ -/= (Windows) 
Command+ -/= (Mac OS 
X) 

N/A 

Delete Selected clip, Multi 
clip or Song clip 

Backspace / Delete N/A 

Choose Tab 

Navigate Choose Tab Up / Down / Left / Right / 
Enter 

Up / Down / Left / Right / Enter* (See 
General > Navigate) 

Cancel Selection / Back Esc N/A 
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Shape Tab > Edit Shape 

Switch between Edit and 
Effects sections of Shape 
Tab 

Up/Down 
(Focus not on an Effect)

Up / Down* (See General > Navigate) 

Adjust Instrument 
Parameters 

N/A Akai Professional MAX25 or MAX49: Faders 
[1-6] 

Akai Professional MPK25, MPK49, MPK61, 
or MPK88: Knobs Bank A [K1-K6] 

Akai Professional MPK mini or LPD8: Knobs 
[1-6] 

Alesis QX25, QX49, or QX61: Knobs [K1-K6] 

M-Audio Axiom AIR 25, Axiom AIR 49, or 
Axiom AIR 61: Knobs [1-6] with the INST./FX 
button next to the knobs lit 

M-Audio Axiom AIR Mini 32: Knobs [1-6] in 
INST./FX mode - to set the mode to INST./FX, 
press the HyperControl button until the LED 
next to "Inst/FX" is lit 

M-Audio Axiom Pro 25, Axiom Pro 49, or 
Axiom Pro 61: Knobs [E1-E6] 

M-Audio Axiom 25, Axiom 49, or Axiom 61: 
Knobs [E1-E6] 

M-Audio Oxygen 25, Oxygen 49, Oxygen 61, 
or Oxygen 88: Knobs [C1-C6] 

M-Audio Venom: Knobs Bank C [1-4] and 
Bank D [1-2] 
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Shape Tab > Effects 

Switch between Edit and 
Effect Section of Shape Tab 

Up/Down 
(Focus not on an Effect) 

Up/Down* (See General > Navigate) 

Navigate Effects Left / Right Left/Right* (See General > Navigate) 

Add/Replace Selected Effect Return / Enter Enter* (See General > Navigate) 

Cancel Selection / Back Esc N/A 

Delete Selected Effect Delete N/A 

Turn On Selected Effect Up Up* (See General > Navigate) 

Turn Off Selected Effect Down Down* (See General > Navigate) 
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Adjust Selected Effect 
Parameters 

N/A Akai Professional MAX49: Faders [1-4] 

Akai Professional MAX25: Faders [1-4] 

Akai Professional MPK61 or MPK88: Knobs Bank 
A [K1-K4] 

Akai Professional MPK49: Knobs Bank A [K1-K4] 

Akai Professional MPK25: Knobs Bank A [K1], 
[K2], [K5], [K6] 

Akai Professional MPK mini or LPD8: Knobs [1], 
[2], [5], [6] 

Alesis QX49 or QX61: Knobs [K1], [K2], [K5], [K6] 

Alesis QX25: Knobs [K1-K4] 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: Knobs [1], [2], [5] and [6] with the INST./FX 
button next to the knobs lit 

M-Audio Axiom AIR Mini 32: Knobs [1], [2], [5] and 
[6] in INST./FX mode - to set the mode to INST./FX, 
press the HyperControl button until the LED next to 
"Inst/FX" is lit 

M-Audio Axiom Pro 49 or Axiom Pro 61: Knobs 
[E1], [E2], [E5] and [E6] 

M-Audio Axiom Pro 25: Knobs [E1], [E2], [E5], [E6] 

M-Audio Axiom 25, Axiom 49, or Axiom 61: 
Knobs [E1], [E2], [E5], [E6] 

M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or 
Oxygen 88: Knobs [C1], [C2], [C5], [C6] 

M-Audio Venom: Knobs Bank C [1-4] 
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Play Tab 

Turn Players On / Off Shift+P Enter* (See General > Navigate) 

Switch Play Mode Left / Right Left/Right* (See General > Navigate) 

Turn Move to Key Sig. 
On / Off 

Up / Down Up/Down* (See General > Navigate) 

Adjust Play Tab 
Parameters 

N/A Akai Professional MAX49: Faders [1-4] 

Akai Professional MAX25: Faders [1-4] 

Akai Professional MPK61 or MPK88: Knobs Bank 
A [K1-K4]

Akai Professional MPK25 or MPK49: Knobs Bank 
A [K1-K4] 

Akai Professional MPK mini or LPD8: Knobs [1-4] 

Alesis QX25, QX49, or QX61: Knobs [K1-K4] 

M-Audio Axiom AIR 25, Axiom AIR 49, or Axiom 
AIR 61: Knobs [1-4] with the INST./FX button next 
to the knobs lit 

M-Audio Axiom AIR Mini 32: Knobs [1-4] in 
INST./FX mode - to set the mode to INST./FX, 
press the HyperControl button until the LED next to 
"Inst/FX" is lit 

M-Audio Axiom Pro 49 or Axiom Pro 61: Knobs 
[E1-E4] 

M-Audio Axiom Pro 25: Knobs [E1-E4] 

M-Audio Axiom 25, Axiom 49, or Axiom 61: 
Knobs [E1-E4] 

M-Audio Oxygen 25, Oxygen 49, Oxygen 61, or 
Oxygen 88: Knobs [C1-C4] 

M-Audio Venom: Knobs Bank C [1-4] 
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Edit Tab > Piano Roll 

Pointer Tool Ctrl+1 (Windows) 
Command+1 (Mac OS X) 

N/A 

Pencil Tool Ctrl+2 (Windows) 
Command+2 (Mac OS X) 

N/A 

Velocity Tool Ctrl+3 (Windows) 
Command+3 (Mac OS X) 

N/A 

Triplet Grid On / Off T N/A 

Align Selection to Current 
Grid Value 

Q N/A 

Override Grid 
(Moving/Resizing Notes) 

Shift+Drag (Windows) 
Command+Drag (Mac OS X) 

N/A 

Copy Selected Notes Ctrl+Drag (Windows) 
Alt+Drag (Mac OS X) 

N/A 

Lock Axis When Moving 
Notes 

Shift-Drag (Mac only) N/A 

Add to Selection Shift+Click N/A 

Select All Notes Ctrl+A (Windows) 
Command+A (Mac OS X) 

N/A 

Move Selected Note(s) 
Up/Down/Left Right by 
grid 

Up / Down / Left / Right N/A 

Zoom In/Out Ctrl+ -/= (Windows) 
Command+ -/= (Mac OS X) 

N/A 

Edit Tab > Wave Editor 

Zoom In/Out Ctrl+ -/= (Windows) 
Command+ -/= (Mac OS X) 

N/A 
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Trademarks and Licenses 
 
Integration with SoundCloud via the SoundCloud API © 2007 – 2012 SoundCloud Limited. 
SoundCloud and the cloud device are trademarks of SoundCloud Limited. 
 
ASIO is a trademark of Steinberg Media Technologies GmbH. 
 
Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. 
 
Mac and OS X are trademarks or service marks of Apple Inc., registered in the U.S. and 
other countries. 
 
All other product or company names are trademarks or registered trademarks of their 
respective owners. 
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